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Document History

The following table provides an overview of the most important document changes.

Caution

Before you start the implementation, make sure that you have the latest version of this document. You can find

the latest version on the Service Marketplace at http://service.sap.com/installnw75%|» Planning 3

Table 1:

Version

1.0

Date

October 20, 2015

Description

Initial Version

11

February 29, 2016

Added information about SAP Business
Planning and Consolidation 10.1, version
for SAP NetWeaver in chapter Data
Warehousing [page 35].

Corrected a paragraph about the SAP
NetWeaver Application Server for ABAP
in chapter Systems with Product Instan-
ces [page 55].

1.2

June 01, 2017

Added information about SAP Gateway
Foundation in chapter Standalone En-
gines [page 68].

Several link and graphic updates
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1 Getting Started

11 About this Document

This Master Guide is the central starting point for the technical implementation of the technology platform SAP
NetWeaver 7.5. It provides you with information about the use cases as well as the installable product instances,
and refers you to the detailed documentation (such as the Installation Guides).

1 Note

The Master Guide is regularly updated. Make sure that you have the latest version by checking http://

help.sap.com/nw75 | Installation and Upgrade 3 immediately before starting the installation.

Constraints

The scenarios that are presented here serve as examples of how you can use SAP software in your company. The
scenarios are intended only as models and do not necessarily run the way they are described here in your
customer-specific system landscape. Check your requirements and systems to determine whether these
scenarios can be used productively at your site. Furthermore, we recommend that you test these scenarios
thoroughly in your test systems to ensure that they are complete and free of errors before going live.

See also

The upgrade or update to this SAP solution is described in the document Upgrade Master Guide — SAP NetWeaver
7.5. The Upgrade Master Guide is available at http://help.sap.com/nw75 || Installation and Upgrade 7.

1.2 Glossary

Short overview of some technical terms as well as SAP NetWeaver key terms:

1 Note
Usage Type, Technical Usage, and Product Instance

The term “product instance” replaces the terms “usage type" and “technical usage” for SAP systems based on
SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731

SAP NetWeaver Master Guide
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. Note that there is no terminology change for older releases and all mentioned terms can be used as

synonyms.

Table 2:

Term

Client

Explanation

Clients are additional installable programs or tools. They reside either on local front-end PCs
accessed by users or on back-end systems where they act as client programs within an SAP
NetWeaver system landscape.

Functional Unit

A configured and activated unit of SAP NetWeaver that provides a set of functions, allowing
the implementation and execution of activities such as process steps within IT scenarios. It is
nestable and can be grouped into larger functional units. Examples include transport manage-
ment system, system landscape directory, adapter framework, and business process engine.

Landscape Pattern

Defines if a technical system is used by one or several product systems to calculate update
and upgrade methods. The landscape pattern can be defined as “hub” system (if used by sev-
eral product systems) or as “sidecar” system (if used by one product system).

LMDB

Landscape Management Database

Central storage and editor for system information in SAP Solution Manager, supplied by a
central SLD. In the LMDB, you manage technical information (such as technical systems and
hosts) and logical information (such as product systems and technical scenarios). This data
is the basis for other applications, like monitoring and alerting, diagnostics, maintenance
transactions, and SAP Support Portal.

Logical Component

Group of technical systems that provide a concrete business function by installed product in-
stances and by different roles (such as development, test, or production system).

Maintenance Optimizer
(MOpz)

Application within SAP Solution Manager up to version 7.1 that guides you through planning
and downloading stack XML files for enhancement packages, support packages, and addi-
tional update packages. These files can be used as input files for the installation by update
tools like Software Update Manager.

The MOpz is replaced by the Maintenance Planner, which is mandatory for SAP systems
based on SAP NetWeaver 7.5 and higher.

Maintenance Planner

Tool on SAP Service Marketplace to visualize the existing system landscape, and to plan and
simulate updates, upgrades, and new installations.

Maintenance planner is a solution hosted by SAP and helps you plan and maintain systems in
your landscape. You can plan complex activities like installing a new system or updating exist-
ing systems. All changes can be scheduled to be deployed at a convenient time, to minimize
downtime. Maintenance planner is the successor of Maintenance Optimizer, Landscape Plan-
ner, and Product System Editor. It simplifies the maintenance process by consolidating criti-
cal tasks such as definition of product maintenance dependencies, implementing changes by
generating stack configuration, downloading archives, and so on, in one tool.
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Term

Product

Explanation

An SAP offering in the SAP price list that performs business tasks.

The complete product model is shipped as SAP Software Catalog. The availability of products
is published in the Product Availability Matrix (PAM). The product model defines the product
structure with its product instances, software components, version, and technical dependen-
cies between product and its components. Products typically have a name starting with
'SAP..." and are characterized by a version period and a maintenance cycle. A product can be
installed on one or more technical systems. All technical systems that are involved form the
product system.

Examples for products are SAP ERP, SAP NetWeaver, and SAP Solution Manager.

Product Instance

Part of a product version that bundles one or more software components.

A product instance is part of only one product version. It must be installed and updated as a
whole on a single technical system. Patches can still be installed for individual software com-
ponents. A product instance can contain other product instances. It can be re-used across
products.

Examples for product instances are SAP ECC Server and SAP NetWeaver AS ABAP.

Product System

A group of technical systems on which a product version is installed. Product system descrip-
tions are used to maintain and plan products in the system landscape.

Product Version

A release of an SAP product.

It bundles product instances and the included software component versions that are available
at a particular time for a specific scope of functionality. Like products, product versions are
shipped in the SAP Software Catalog. They are the basis for the compatibility of closely cou-
pled systems and the maintenance of product systems.

An example is SAP ERP 6.0, which is a product version of the product SAP ERP.

Optional Standalone Units

Optional standalone units are additional software units that you install separately. They are
based on Application Server Java (AS Java) and provide specific (server) functions in combi-
nation with one or more SAP systems.

SLD

System Landscape Directory

Central provider of information on technical systems, for consumers in the system landscape
and for external consumers. The SLD obtains its information mainly from SLD data suppliers,
which are installed on the technical systems, and from the SAP software catalog.

With the SLD, you collect and edit system data that is required for system landscape manage-
ment. This information can be used by other consumers, such as SAP Process Integration,
Web Dynpro for Java, and SAP Solution Manager.

6 PUBLIC
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Term

Software Component

Explanation

Delivery and product unit of an SAP software product

A software component comprises a set of packages that are delivered in a single unit. You al-
ways assign repository objects to a software component by assigning the package containing
these objects. This makes it possible to move repository objects from one software compo-

nent to another during a release upgrade. A software component is released in successive re-
leases with new functions. You can import patches into each software component separately.

Software Provisioning Man-
ager

A tool that performs software provisioning processes such as installation, uninstallation, sys-
tem copy, or system transformation. The Software Provisioning Manager is delivered with the
Software Logistics Toolset.

Stack configuration file

The stack configuration file is created by the Maintenance Planner and is system-specific. De-
pending on the software components that are installed in a system, the Maintenance Planner
calculates the required software components that have to be updated to reach a certain tar-
get configuration.

Standalone Engine

Standalone engines of SAP NetWeaver are additional installable software units. They do not
work as full-blown systems of SAP NetWeaver, but as standalone engines that provide a spe-
cific (server) function in combination with one or more SAP NetWeaver systems. Standalone
engines are not part of a product instance. They do not run on AS ABAP or AS Java.

Technical System

Describes a part of a product's software that is installed on one or several physical or virtual
hosts.

A technical system is installed and administered as a whole. It is identified by a system ID
(SID) or extended SID, a host, and an installation number. There are different technical sys-
tem types, for example Application Server (AS) ABAP, AS Java, or TREX. Technical systems
are central elements when it comes to software component deployment and operational ac-
tivities, such as monitoring and alerting.

Update

Activities to maintain or enhance a system, such as installing enhancement packages, instal-
ling add-ons, or applying support package stacks or support packages.

Note: The tool for system maintenance tasks is the Software Update Manager (SUM). In the
SUM guide, the term "Update" is used as collective term for all the tasks that can be per-
formed using this tool (such as performing release upgrades, installing enhancement pack-
ages, or updating a system with Support Package Stacks).

Upgrade

The switch from an older software version to a new version. Typically, both the server compo-
nent of a system landscape and other components are upgraded. Several different technical
upgrade procedures are used to upgrade the server component, such as the Repository
Switch upgrade or the System Switch upgrade.

SAP NetWeaver Master Guide
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Term Explanation

Usage Type Note: This term has been replaced by Product Instance. See note at the beginning.

An installed and correspondingly configured part of an SAP NetWeaver system that provides
key capabilities for a system landscape. It specifies the intended purpose of a system, and it is
the result of the configuration of the underlying installed software units and the configuration
of the underlying functional units. Examples include business intelligence, process integra-
tion, and SAP Enterprise Portal.

Use Case A definition of use from the end users' perspective for accomplishing a specific goal within a
system. Use cases represent the main capabilities of the system to fulfill specific require-
ments.

1.3 SAP NetWeaver Use Cases

Use

The use cases illustrate how you can use your SAP NetWeaver implementation. The main use cases of SAP
NetWeaver and their corresponding key areas of SAP NetWeaver are as follows:

Table 3:
Use Case Corresponding Key Area of SAP NetWeaver
Building Composite Applications SAP Composition Environment
Data Warehousing SAP Business Warehouse
Building Integration Scenarios SAP Process Integration

Integrating and Self Servicing Content with SAP Enterprise SAP Enterprise Portal

Portal
Mobilizing Business Processes SAP NetWeaver Mobile
Custom Application Development (ABAP) (All areas that allow ABAP development on the SAP NetWea-
ver Application Server ABAP)
Constraints

As of SAP enhancement package 1 for NetWeaver 7.3, SAP NetWeaver Mobile is only available as add-on to SAP
NetWeaver. For more information, see SAP Note 1645275 .

SAP NetWeaver Master Guide
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More Information

You can obtain all information about the key areas with regard to SAP NetWeaver 7.5 in the SAP Help Portal and in
SAP Community Network (SCN):

e SAP Help Portal
SAP Help Portal bundles access to SAP product documentation and also related information, such as SAP
Notes, product availability information, as well as community content.
For SAP NetWeaver 7.5, you access the Help Portal using the address http://help.sap.com/nw75#r .

1. Choose|r Application Help » <key area> Jfor an introduction to and an overview of the application.

2. Choose |l Application Help » Function-Oriented View » <functional area> 1 for a component-based
reference of all functions and tasks that can be performed with the product.
e SAP Community Network (SCN)

The SCN is organized into more than 300 “spaces”, which support small, self-contained communities. These
communities are typically focused around a topic, an SAP product, or an industry. Each space contains a
complete set of social networking tools including a discussion forum, a blogging area, and an area where you
can publish and collaborate on documents.

As a logged-on member, you can go to any space in the SCN landscape but it's likely that you will be
interested in visiting and following a particular set of spaces that reflect your particular range of interests and
where members who share your interests are likely to hang out.

SCN spaces are where you get the latest news from SAP and the community, where you interact with your
peers, where you earn points for your contributions, and where you establish reputation as being expert on
certain topics
You access the SCN using the address http://scn.sap.com .

1. Tolearn more about SAP NetWeaver, choose:

o |» Products » tab “Technology” » Application Foundation/Integration » SAP NetWeaver J or

o |» Lines of Business ¥ Information Technology & SAP NetWeaver 3
o http://scn.sap.com/community/netweaver

2. Moreover, SAP Community Network provides you with detailed information regarding the SAP
NetWeaver use cases:

Table 4:

For the use case choose in the SCN Community:

Integrating and Self Servicing Content with SAP Enterprise Ib Products ¥ tab “Technology” ¥ Application Foundation/

Portal ) o
Integration » SAP NetWeaver » Team Productivity » SAP

Enterprise Portal }

or choose http://scn.sap.com/community/enterprise-portal

i

Data Warehousing |} Products > tab “Technology” > Application Foundation/
Integration > SAP NetWeaver > Information Management >
SAP Business Warehouse }

or choose http://scn.sap.com/community/data-warehous-
ing/bw

SAP NetWeaver Master Guide
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For the use case choose in the SCN Community:

Building Composite Applications | Products # tab “Technology” ¥ Application Foundation/
Integration > SAP NetWeaver > Process Orchestration >

Business Process Management }

or choose http://scn.sap.com/community/bpm#

Custom Application Development |» Products # tab “Technology” ¥ Application Foundation/

Integration > Custom Development > ABAP Development ]

or choose http://scn.sap.com/community/abap#

Mobilizing Business Processes | Products » tab “Technology” ¥ Enterprise Mobility 4

or choose http://scn.sap.com/community/mobile fr

Building Integration Scenarios | Products # tab “Technology” ¥ Application Foundation/
Integration > SAP NetWeaver > Process Orchestration >
Process Integration & SOA Middleware ]

or choose http://scn.sap.com/community/pi-and-soa-mid-
dleware

1.4 Business View of the Use Cases

For implementation and configuration purposes, the SAP NetWeaver use cases are structured according to the
business view of SAP's Software Portfolio. This portfolio is structured using elements such as

e Solutions

e Solution Editions

e Key Capabilities / Scenario Groups

® Scenarios / Processes

Various tools, services, and processes, such as the Business Process Repository for the SAP Solution Manager,
use the business view of the SAP Software Portfolio.

SAP NetWeaver Master Guide
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The following table displays the structured business view of the use cases in the SAP Solution Manager:
Table 5:

Use Case Includes the Scenarios or Processes

Corresponds to Business Scenario

Group or Key Capability

Building Composite Applications

Building Composite Applications

Business Rules Management

Java Development and SOA Infra-
structure

Process Composition

Data Warehousing

Enterprise Data Warehousing

Data Modeling

Define Data Flow
Metadata Management
Performance Optimization

Scheduling and Monitoring

Building Integration Scenarios

Building Integration Scenarios

Building Integration Scenarios

Building integration-centric processes

Building integration-centric proc-
esses using the single-SID Pl and
BPM solution

Integrating and Self Servicing Content
with SAP Enterprise Portal

Integrating and Self Servicing Content
with SAP NetWeaver

Building Communities with Wikis &
Forums

Content Management Scenarios
with Knowledge Management
Managing and mashing up portal
pages with Web Page Composer
Portal Landscape Interoperability
and Openness

Unified Access to Applications and
Processes

Mobilizing Business Processes

Mobilizing Business Processes

Developing Mobile Applications for
Occasional Connection

Enabling Mobile Applications for Oc-
casional Connection*

Custom Application Development
(ABAP)

Custom Application Development
(ABAP)

Custom Application Development
(ABAP)

Application Lifecycle Management

Application Lifecycle Management

SAP NetWeaver Master Guide
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1.5 Mapping of Use Cases to Installable Software Units

To give you a quick overview of SAP NetWeaver 7.5, the table below shows the mapping between use cases and
required SAP NetWeaver software units. For details about the software units, see section Description of Software
Units [page 55].

Table 6:
Use Case Product Instance Standalone Engines Optional Standalone | Clients
Units
Building Composite Ap- | ® AS Java e SAP NetWeaver
plications: [page 20] e Adobe Document Developer Studio
) . . Vi
Business Rules Ser\./lces (optional) Visual Cf)mposer
Management and ® Business Process ° Ado.be LiveCycle
Process Composition Management and Designer (Op-
Business Rule tional)
Management e Web Browser

e Composition Envi-
ronment Platform

e DIl [optional]

Building Composite Ap- | ® AS Java e SAP NetWeaver
plications: [page 20] e DI [optional] Developer Studio

i - [ ]
Java Developmentand | ® Enterprise Serv Web Browser

SOA Infrastructure ices Repository

SAP NetWeaver Master Guide
12 PUBLIC Getting Started



Use Case

Data Warehousing
[page 35]

Product Instance

AS ABAP

BW ABAP

AS Java

Bl Java [optional]
or, alternatively,
SAP BusinessOb-
jects Business In-
telligence platform
* [optional]

EP Core — Applica-
tion Portal [op-
tional]

Enterprise Portal
[optional]

Standalone Engines

Search and Classifica-
tion (TREX)

Optional Standalone
Units

Clients

SAP GUI with Busi-
ness Explorer (Bl
add-on)

Modeling Tools for
SAP BW, powered
by SAP HANA (BW
Modeling Tools)
SAP BusinessOb-
jects Analysis, Edi-
tion for Microsoft
Office* [optional]
SAP Crystal Re-
ports* [optional]
SAP BusinessOb-
jects Dashboards
[optional]

SAP BusinessOb-
jects Web Intelli-
gence* [optional]
SAP BusinessOb-
jects Design Stu-
dio* [optional]

Building Integration
Scenarios [page 28]

Application Server
Java

Application Server
ABAP

Process Integra-
tion

Enterprise Serv-
ices Repository

Process Integra-

e Adapter Engine
(Java SE) [op-
tional]

Advanced Adapter
Engine [optional]
Advanced Adapter
Engine Extended

tion Adapter En-
gine
Integrating and Self AS Java
Servicing Content with EP Core — Applica-
SAP Enterprise Portal tion Portal
[page 39] EP

Portal Add-on (for
Building
Communities with
Wikis and Forums
only)

SAP NetWeaver Master Guide
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Use Case Product Instance Standalone Engines Optional Standalone Clients
Units
Mobilizing Business e ASABAP e SAPGUI
Processes: [page 37] e Mobile e SAP NetWeaver
Developing Mobile e Application Server Developer Studio
Applications for Java e Mobile Client
Occasional Connectivity | ® bl
® FEP Core - Applica-
Enabling Mobile )
o tion Portal [op-

Applications for tional]
Occasional Connectivity
Custom Application e ASABAP e SAPGUI
Development [page e ABAP Develop-
41] ment Tools

(Eclipse)
SAP Knowledge Ware- | ® ASABAP e Searchand Classi- e Web Browser
house [page 40] e ASJava fication (TREX) e SAPGUI (KW Add-

e Content Server onincluded)

*Note that SAP BusinessObjects products require separate licenses.

1.6 Enhancement Packages

1.6.1 Enhancement Package Concept

We have adapted our major release strategy to better fit your adoption cycle. To ensure that you benefit from new
developments and innovations while minimizing the impact on your core operational systems, SAP uses
enhancement packages to speed up the delivery of new functions.

With SAP enhancement packages, you can install and activate new functions depending on your business needs
without having to perform a system upgrade.

You can selectively implement the new functions and activate the software upon business demand. As a result,
you can isolate the impact of software updates and make new functions available faster due to shortened test
cycles.

Implementation

There are three different scenarios to implement an enhancement package:

e |nstallation of an enhancement package on an existing SAP system

SAP NetWeaver Master Guide
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® New installation of an SAP system including an enhancement package
e Upgrade of an SAP system including an enhancement package

Maintenance

SAP enhancement packages have support packages of their own that are equivalent to the support package
versions of the underlying SAP system. We highly recommend installing the enhancement package in
combination with the latest available support package stack. This approach reduces installation, modification
adjustment, and testing effort. Using this strategy, you can install SAP enhancement packages as a normal
maintenance activity together with support package stacks.

An enhancement package requires a specific support package stack level in the source release SAP system.

1 Note

If the SAP system is on a lower support package stack level, all relevant support package stacks for the
enhancement package installation are automatically included into the download queue by the Maintenance
Planner, as well as the latest available support packages for the enhancement package.

For a better understanding of the general concepts and principles of updating a system, see the Maintenance

Planning Guide and the Planning Landscape Changes - A Best Practice Guide at http://wiki.scn.sap.com/wiki/x/

VIwqCw# | column “Guides" 3

Tools

The enhancement package installation requires the following tools:

1. SAP Solution Manager

1 Note

Use of SAP Solution Manager is mandatory.

Tool versions:

We recommend that you always use the latest version of the SAP Solution Manager. For more information,
see SAP Support Portal at http://support.sap.com/solutionmanager #r.

System Landscape Maintenance with SAP Solution Manager:

Make sure that you have correctly defined and maintained your system landscape in SAP Solution Manager.

Use the Landscape Management Database (transaction L.MDB) for the complete system description.
For more information about the Landscape Management Database (LMDB), see http://help.sap.com/

solutionmanager71&|» Application Help » SAP Library SAP Solution Manager 7.1 <SP version> » SAP

Solution Manager Operations » Landscape Management Database (LMDB) » Managing System Landscape

Information .

SAP NetWeaver Master Guide
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2.

Landscape Verification with SAP Solution Manager:

To verify and correct your system landscape, SAP highly recommends that you use the verification functions
of the SAP Solution Manager. Use for this the landscape verification function that is embedded into the
product system editor of the Landscape Management Database (LMDB).

For more information about the landscape verification, see SAP Community Network athttp://scn.sap.com/
docs/DOC-8793# .

= Recommendation

Before installing the enhancement package, we recommend running a landscape verification to check your
landscape setup and your system descriptions, and to correct data if necessary.

Installation or upgrade tools (depending on your scenario)

o SAP Maintenance Planner
The maintenance planner is a hosted solution offered in SAP Support Portal, and lets you effectively plan
and maintain your landscape. It is the successor of Maintenance Optimizer, landscape planner, and the
product system editor in the LMDB. The maintenance planner consolidates critical tasks such as defining
product maintenance dependencies, generating stack configuration files, and selecting archives in a
single tool. The stack XML created by the maintenance planner can be consumed by Software Update
Manager (SUM) to update an existing system, or by software provisioning manager (SWPM) for new
installations.
For more information about the maintenance planner, see http://wiki.scn.sap.com/wiki/x/VIwqCw ¥ .

o Software Provisioning Manager 1.0
For the new installation of an SAP system including an enhancement package you use the standard
installation tool software provisioning manager 1.0. For more information about the tool, see https://
support.sap.com/sltoolset .

o Software Update Manager (SUM)
To install an enhancement package on an existing SAP system, as well as for the upgrade of an SAP
system to a higher release including an enhancement package, you use the Software Update Manager
(SUM).

For more information bout the Software Provisioning Manager and the Software Update Manager see

https://support.sap.com/sltoolset .

1.6.2 Key Facts About Enhancement Packages

The following list summarizes important facts about the enhancement package concept and recommended
approaches:

16

You cannot mix the installation of different enhancement package versions in your ABAP-based SAP system.
You can have just one enhancement package version in the SAP system. This means, if you have already
updated product instances to a previous EHP you need to apply the current EHP to those components as well.
SAP enhancement packages are cumulative, meaning that each new enhancement package includes new
innovations of its own as well as all innovations delivered with prior packages.

We recommend installing the latest available enhancement package version.

Install enhancement packages and support packages in one single step (this includes the preconditioned
support packages).

SAP enhancement packages have support packages of their own that are equivalent to the support package
versions of the underlying SAP system.
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e SAP enhancement packages have the same maintenance period as the underlying core application.
e The installation of an enhancement package is irreversible.
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2 Planning SAP NetWeaver 7.5

The general sequence for the implementation of an SAP NetWeaver system is as follows:

O

You plan the system landscape for the use cases.
You install the components of your SAP NetWeaver system.
You configure your systems.

You plan the implementation (such as scope, hardware and software requirements, release restrictions).

You carry out further post-installation steps according to the Software Provisioning Manager guide.

In the following, you find information about the planning steps for SAP NetWeaver 7.5.

e Major Planning Steps and Related Documentation [page 18]

® Planning the Uses Cases and their System Landscapes [page 19]

2.1 Major Planning Steps and Related Documentation

During an implementation project, you have to take into account many aspects and to take various decisions. The
major planning steps of this process are outlined below.

Caution

Unicode

SAP NetWeaver 7.5 supports Unicode only. A “Combined Upgrade & Unicode Conversion (CU&UC)" with
target SAP NetWeaver 7.5 is not possible. Make sure, that the SAP NetWeaver source system already supports

Unicode.

Table 7:

Step

Scope and Requirements

’ Step Description

You determine the scope of your SAP Net-
Weaver implementation.

Further Information

For more information, see SAP NetWeaver
Use Cases [page 8].

Installable Software Units

You determine which installable software
units (that is, systems with product instan-
ces, standalone engines, optional stand-
alone units, and clients) are required for the
use cases.

For more information, see the Mapping of
Use Cases to Installable Software Units
[page 12] section.

For details about the software units, see De-
scription of Software Units [page 55].

Landscape Planning

You determine the system landscape and
consider the landscape-relevant aspects
concerning your required use case.

See Planning the Uses Cases and their Sys-
tem Landscapes [page 19].
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Step Description Further Information

Hardware & Software Prerequi- | Use the Product Availability Matrix (PAM) to | http://support.sap.com/pam
sites check which platforms (operating systems,
databases, browsers) are supported for
your SAP NetWeaver components.

Check the recommended minimum data- See SAP Note 2158828 .
base versions.

Check which hardware sizing is required for http://service.sap.com/sizing&
your SAP NetWeaver release.

Release Restrictions Check SAP Notes for any release restric- Regarding SAP NetWeaver 7.5 release re-
tions. strictions, see SAP Note 2206460 #% .

SAP Solution Manager Prerequi- | We recommend always using the latest SAP | ®  See SAP Note 631042#% for informa-

sites Solution Manager release. tion about the Release strategy for Im-
plementation Content (ST-ICO).

e See SAP Note 781448 for informa-
tion about Support Package levels of

Make sure that your SAP Solution Manager
system has the required support package

level and content.
SAP Solution Manager installations and
Check if you need to do an update or up-

grade of your SAP Solution Manager appli-

upgrades.
e The Solution Operations Guide for SAP
Solution Manager is available at:http://

After an upgrade or update to the latest SAP service.sap.com/instguidesl'hrw SAP
Solution Manager release, you need to carry

cation or content.

) ) ) Components ¥ SAP Solution Manager
out follow-up actions as described in the

section Software Change Management of
the Solution Operations Guide.

» <Release> ¥ Operations 3.

2.2 Planning the Use Cases and their System Landscapes

In the following, you get information about the system landscapes for the different SAP NetWeaver uses cases

e Building Composite Applications [page 20]

e Building Integration Scenarios [page 27]

e Data Warehousing [page 35]

e Mobilizing Business Processes [page 37]

® |ntegrating and Self-Servicing Content with SAP Enterprise Portal [page 39]
e SAP Knowledge Warehouse [page 40]

e Custom Application Development (ABAP) [page 41]

For some uses cases, you get some additional planning information.
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= Recommendation

e For more details and aspects regarding the System Landscape Design and Infrastructure, we refer you to
the information about Landscape Design and Infrastructure that you can access from the document
Technical Enablement - Application Lifecycle Management in the Software Community Network (SCN).

Choose http://scn.sap.com/docs/DOC-23404#%|p Landscape Design and Infrastructure 4.
e See also the information about Preparing the System Landscape Directory (SLD) in the SAP NW75 Library,

available at http://help.sap.com/nw75#% | System Administration and Maintenance Information »
Technical Operations for SAP NetWeaver » Section: Administration of SAP NetWeaver systems and
components » Technical Operations for SAP NetWeaver Development Infrastructure (DI) » Development
Infrastructure (DI) » Configuring the Development Infrastructure  Preparing the System Landscape

Directory (SLD) 3.
e Furthermore, see the information about Managing System Landscape Information in the Help Library for
the SAP Solution Manager.

Choose http://help.sap.com/solutionmanager71#&|p Application Help  SAP Library ¥ SAP Solution
Manager 7.1 SP<version> » SAP Solution Manager Operations » Landscape Management Database

(LMDB): » Managing System Landscape Information .

2.2.1 Building Composite Applications

SAP Composition Environment provides design time and runtime infrastructures for developing, running, and
managing composite applications that comply with SAP Enterprise Service-Oriented Architecture (enterprise
SOA) technologies. Composite applications use this service-oriented architecture to fill the gaps that standard
solutions cannot cover.

With Process Orchestration, you can combine the process modeling, operation, and monitoring capabilities of
SAP Business Process Management (SAP BPM) with the integration capabilities of SAP Process Integration
(Advanced Adapter Engine Extended (AEX) installation option). For more information, see Process Orchestration
[page 33].

2.211 System Landscape

In order to plan the system landscape for SAP Composition Environment (SAP CE) you should start by answering
the following questions:

e Which back-end systems are required?

The answer to this question depends on the functions and data you would like to use to build your composite
applications, and whether you want to continue using existing software, such as the software lifecycle
management functions of your back-end system.

e \Which central product instances of SAP NetWeaver can be shared when using SAP CE in combination with
SAP Enterprise Portal or in combination with SAP Process Integration (SAP PI1)?

SAP NetWeaver Master Guide
20 PUBLIC Planning SAP NetWeaver 7.5


http://help.sap.com/disclaimer?site=http://scn.sap.com/docs/DOC-23404
http://help.sap.com/disclaimer?site=http://help.sap.com/nw75
http://help.sap.com/disclaimer?site=http://help.sap.com/solutionmanager71

The following graphic gives an overview of SAP CE in a system landscape using SAP Process Integration, SAP
Enterprise Portal, and already existing back-end systems:

SAP NetWeaver 7.5 Systems Back-End Systems
SAP NetWeaver Systems
SAP NetWeaver Portal
SAP NetWeaver 7.5 SAP NetWeaver 7.4

Additional Portal Product Instances

SAP NetWeaver 7.0 SAP NetWeaver 7.0
EP
=z SAP NetWeaver CE
= SAP NetWeaver 7.0 SAP ERP
5 - .
5 Composition Environment Platform “ SAP NetWeaver
(=}
7 Portal -
o
<
o
n;T Additional CE Product Instances
o
Other Systems
ES Repository Thirdparty
Development Non-SAP Back-End
Infrastructure Systems
Additional Pl Product Instances
ES Workspace
SAP NetWeaver Pl (SDN)

Figure 1: SAP CE Combined with Other Use Cases and Back-End Systems

The following sections give recommendations for possible shared usages or installation requirements in your
system landscape, for example, with respect to the following options shown in the graphic above:

e Enterprise Services Repository can both be used for SAP CE and SAP PI. See section Working with Enterprise
Services Repository below for more details.

e The Composition Environment Platform contains the functional unit Portal that offers — apart from minor
exceptions — the same functionality as product instance EP Core — Application Portal for SAP Enterprise
Portal. See section Working with SAP Enterprise Portal below for more details.

Connecting to Back-End Systems

You can integrate and use a back-end system in the following scenarios:

® You access data residing on a back-end system.
You can reuse existing data in the composite applications. For example, if you want to use data residing in an
SAP ERP system, you can use the SOA capabilities (in SAP ERP 6.0 systems based on SAP NetWeaver 7.0
Support Package Stack 9 or higher) or you can connect using Remote Function Calls (RFC) to older systems
using the Java Connector (JCo) that is offered as a part of SAP NetWeaver AS Java.

® You use enterprise services on SAP or non-SAP back-end systems.
You can leverage the SOA capabilities of SAP NetWeaver by consuming services provided by an SAP back-
end system such as SAP ERP 6.0 (on SAP NetWeaver 7.0 SPS9 or higher), or the ES Workplace that you can
access using the SAP Community Network (SDN) at http://scn.sap.com/community/soafs. Note that you
can use the ES Workplace in this context only to try some features out, it is not intended for productive use.
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In addition, you can consume services from a third-party back-end system using the standard-based web
service capabilities of the stack. The SAP NetWeaver AS Java installation includes a Services Registry that
enables you to browse the registered service definitions.

Working with Enterprise Services Repository

As a prerequisite for using Enterprise Services Repository (ES Repository), the System Landscape Directory is
needed where products and software components are maintained. You can create your own products and
software component versions in the System Landscape Directory. Before the start of development, you need to
import the required software component versions from the System Landscape Directory into the ES Repository.

1 Note

Note that the following JAVA archives are installed among other software components as part of Enterprise
Services Repository:
® ChartDirector.jar

® Jjide.jar

We recommend using Enterprise Services Repository on the same AS Java where you use the Services Registry
for building composite applications.

If you use SAP NetWeaver systems for building composite applications and for building integration scenarios
(using SAP PI), we strongly recommend maintaining all your design objects in one ES Repository.

SAP Plis tightly coupled with ES Repository and requires configuration to connect to a given ES Repository. By
default, Pl connects to the default ESR delivered with SAP PI, while you can use any ES Repository for building
composite applications. We recommend using the latest version of ESR in the landscape.

More information at: http://help.sap.com/nw75%% | Application Help » SAP Composition Environment »
Administrator's Guide » Configuring Composition Environment » Configuring Additional Components ¥

Configuring Enterprise Services Repository ¥ Configuring a Central ES Repository in a CE and Pl Landscape 3.

Working with SAP Enterprise Portal

Integrating Applications into SAP Enterprise Portal

Once you create and run your applications on the SAP CE system, you can use standard portal capabilities for
integrating Java applications into iViews.

e For back-end connectivity to SAP transaction and BEx Web iViews, use the portal system landscape overview.

e To enable back-end connectivity for other application types, such as composite views and processes, use
Remote Function Calls (RFCs) and Web services, which are configured in SAP NetWeaver Administrator.

For more information, see http://help.sap.com/nw75#& | Application Help » SAP Composition Environment »
Administrator's Guide » Administering Composition Environment » Additional Administration Tasks # Integrating
Content into the SAP Enterprise Portal CE 3.
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Running Composite Applications in SAP Enterprise Portal

Once you have integrated your composite applications into SAP Enterprise Portal, the following scenarios have to
be distinguished:

® Running composite applications in a portal when developing and testing them in your landscape.
e Allowing business users to access composite applications in a productive environment.

Depending on the scenario, either product instance Composition Environment Platform (CEP) is sufficient or a
local Portal installation (product instances EPC — Applications Portal (EPC) and optionally Enterprise Portal (EP)),
or aremote SAP Enterprise Portal installation is required. In the following table, the terms local and remote are to
be understood from the viewpoint of an SAP NetWeaver 7.5 installation:

Table 8:

Developing and Testing Accessing Composite Applications in Productive Environ-

ments

SAP NetWeaver 7.5 ® SAP NetWeaver 7.0 3rd Party Solution

e SAP NetWeaver 7.0 in-
cluding enhancement
package lor 2

e SAP NetWeaver 7.3

e SAP enhancement pack-

age 1 for NetWeaver 7.3
e SAP NetWeaver 7.4
Product e or SAP NetWeaver 7.5
Required Product Instance EPC* EPC* (EP*¥) —
Type of Access Local Local (SAP NetWeaver 7.5) Remote

and remote (SAP NetWeaver
7.0, SAP NetWeaver 7.0 in-
cluding enhancement pack-
age lor 2, SAP NetWeaver
7.3, SAP enhancement pack-
age 1 for NetWeaver 7.3, SAP
NetWeaver 7.4, and SAP Net-
Weaver 7.5)
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Developing and Testing Accessing Composite Applications in Productive Environ-

ments

Additional Information Note that the portal installed | You can enable the runtime —
with product instance Com- access of composite applica-
position Environment Plat- tions from a remote

form can function as a pro-
ducer portal only; consumer

e SAP NetWeaver 7.0

e SAP NetWeaver 7.0 in-

capabilities are therefore not )
cluding enhancement

supported.
PP package lor 2

e SAP NetWeaver 7.3

e SAP enhancement pack-
age 1 for NetWeaver 7.3

e SAP NetWeaver 7.4

® or SAP NetWeaver 7.5

portal, either by using the
SAP NetWeaver Portal iView
Wizard, or by setting up a fed-
erated portal network.

* The installation of product instance EPC allows you — in addition to the functions provided by product instance
Composition Environment Platform — to enable the runtime access of composite applications in the portal on the
local system using GPAL and the iView wizards.

** Product instance EP requires product instance EPC and extends the portal to a full Enterprise Portal. For more
information, see section System Landscape Aspects for Integrating and Self-Servicing Content with SAP
Enterprise Portal [page 39].

For more information about enabling runtime access from a remote SAP NetWeaver 7.0, SAP NetWeaver 7.3; SAP
enhancement package 1 for NetWeaver 7.3, SAP NetWeaver 7.4, or SAP NetWeaver 7.5 portal, see http://
help.sap.com/nw75®||» Application Help » SAP Composition Environment » Administrator's Guide
Administering Composition Environment  Additional Administration Tasks » Running CE Applications in Remote
Portals (Optional) .
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2.2.1.2 Further Aspects for Your Installation Planning

Overview

The following graphic shows the software units that are used for Building Composite Applications:

Clients

Sevel Adobe
%"J'[e -:i)_per Web Browser LiveCycle
uaio Designer
|

Systems with Product Instances Standalone

Engines
BPM and BRM
. . Web
CE Platform DI (optional) ADS (optional)

AS Java

Visual

Composer

Dispatcher

Figure 2: Software Units for Building Composite Applications
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Clients

Developer Studio Web Browser

Systems with Product Standalone Engines
Instances

. Web
DI (optional)

Dispatcher

AS Java

When setting up the system landscape, you need to consider the development environment for each developer
and the overall system landscape for developing, testing, and running composite applications.

We recommend using a combination of development system, test system, and production system with a central
AS Java to develop, consolidate, test, and run your application productively. This system landscape is also the
preferred option for developing a composite application in a team of developers.

To describe this scenario, the following sections focus on the AS Java and the Developer Studio, because the
installation is tailored to these main software units. Of course, additional product instances or clients need to be
installed in addition depending on your scenario.

For information about supported operating systems and databases, see the Product Availability Matrix for SAP
NetWeaver 7.5 available at http://support.sap.com/pam#.

Planning Your Installation of SAP NetWeaver Development, Test, and
Production Systems for Composite Applications

When using SAP NetWeaver for development of composite applications aimed for productive use, we strongly
recommend setting up a system landscape consisting of the following systems:

e Development System and Test System
Use these systems for development and quality assurance.
® Production System
Use this system to run your applications separately from your development and test landscape.

The system landscape supports consolidating and testing individual development and, as a consequence, is
strongly recommended for team development projects.
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The following graphic provides an overview of the recommended system landscape:
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Figure 3: Recommended SAP NetWeaver system landscape

With respect to the installation of the development environment, you install a AS Java centrally and Developer
Studio instances on each developer host. This option requires fewer hardware resources per developer host. In
this landscape scenario you can set up an AS Java in development mode centrally and connect to it from the other
hosts in the landscape using the Developer Studio.

In a production system landscape, you have to install a central 64-bit SAP NetWeaver Application Server Java in
productive mode for running composite applications to address additional runtime requirements such as
clustering and higher default memory settings. We strongly recommend installing a central 64-bit server in
productive mode for both the test system landscape and the development system landscape as well.

2.2.2 Building Integration Scenarios

You can either install SAP Process Integration (PI) in different ways:

e Standard Pl dual usage type installation, that is, installation of AS ABAP (Pl ABAP) and the AS Java (Pl Java)
on separate system IDs (SID)

e Advanced Adapter Engine Extended (AEX): Based on AS Java only
Both options are described in System Landscapes for Pl and AEX [page 28].

Furthermore, you have the possibility to install the Process Orchestration [page 33].
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Caution
Dual-Stack Systems

Note that SAP NetWeaver 7.5 does not support any dual-stack systems, that is, an ABAP stack and a Java
stack integrated in one single system with a common system ID, a common startup framework, and a common
database.

Such dual-stack implementations can still exist in former SAP Process Integration installations. However, note
that a single-stack SAP Process Integration Java (Advanced Adapter Engine Extended) exists that offers
almost all of the features of classical dual-stack implementations.

Therefore, you should investigate if a Java-only implementation of SAP Pl is a feasible approach for your use
cases. Due to the harmonized process orchestration stack (SAP Pl and SAP Business Process Management
(SAP BPM) running on the same Java instance), stateful system-centric processes can be developed using
SAP Process Orchestration capabilities. Processes that are created with ccBPM need to be redesigned and
modeled with SAP BPM. For more information about how to do this, see SAP Community Network at: http://
scn.sap.com/docs/DOC-28803#

2.2.2.1 System Landscapes for Pl and AEX

Use

The Pl dual usage type installation based on both an ABAP stack and a Java stack (dual-stack) offers the
complete functional range, whereas the functional range of Advanced Adapter Engine Extended (AEX) is
restricted, but has the advantage of a lower TCO. Note that in the Pl dual usage type installation both the Java
stack and the ABAP stack have their own system ID (SID1 and SiD2).
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The following figures depict both options:

ES Repository, Integration Directory

Advanced Advanced Adapter
| AdapterEngine Engine (Mon-
| (Central) Central)

P
II Business

System

Adapter Engine
(Java SE)

Figure 4: System Landscape for Building Integration Scenarios with Pl Standard Installation

1 Note

When you choose the Process Integration installation option in the installation tool, all dependent product
instances are selected and installed automatically.
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Figure 5: System Landscape for Building Integration Scenarios with Advanced Adapter Engine Extended (AEX)

When you plan your system landscape for building integration scenarios, consider the following aspects:

e |tis mandatory to have a dedicated Pl system. This applies to development, quality, and production
landscapes.
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For PI, it is a prerequisite that no other system in your system landscape has a higher release than the Pl
system. For exceptions to this rule, see SAP Note 1043047#% . Apart from these exceptions, if you want to
upgrade or install an application in your system landscape, you first have to make sure that the Pl system is
on the same release level. If required, you have to upgrade the Pl system first to the new or a higher release.

Caution

Although it should be technically possible to run an application system with a higher release than your PI
system in your system landscape, this is not supported by SAP (apart from the exceptions listed in SAP
Note 1043047#% ). Therefore, you run such a landscape at your own risk.

® You can use the Advanced Adapter Engine that is part of your Pl system as a central Advanced Adapter
Engine. You can optionally deploy additional non-central Advanced Adapter Engines.
Adapter Engine (Java SE) can be installed in a non-SAP Java environment. However, it only hosts a subset of
the adapter functionality, is only supported for compatibility reasons, and should be used only if this is a
precondition in your environment. The following table shows the characteristics of the central Advanced
Adapter Engine, the non-central Advanced Adapter Engine, and the Adapter Engine (Java SE) as an overview:

Table 9:
Central Advanced Adapter Engine on the Pl host o No additional installation procedure required

o Suitable for development or test scenarios

o Data source (file, database, JMS provider) must be ac-
cessible using NFS, tcp-ports, and so on (may only be
available in homogeneous LAN environments).

o Possible performance bottleneck due to high RAM
needs. The system needs three times the amount of
the maximum message size as RAM, for example.

Non-central Advanced Adapter Engine © Provides complete integration into the Pl environment:
o Central Monitoring available
o Central Configuration available

o More resources needed for installing the SAP NetWea-

ver Java system
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Installation Option Characteristics
Adapter Engine (Java SE) o Installation possible on non-released SAP NetWeaver
platforms

o Only HTTP connection required between adapter en-
gine and Integration Server. Suitable for a more hetero-
geneous system landscape with mixed operating sys-
tems and authorization concepts, or for distributed
WAN environments with firewalls, and so on.

o Fewer resources needed when running in a Java envi-
ronment only

o Additional installation procedure required for JDK and
the adapter itself

o Poorer integration with the SAP Process Integration
environment due to lack of central configuration and

monitoring services

® You caninstall an Advanced Adapter Engine Extended (AEX). This provides tools for designing and
configuring integration content (Enterprise Services Repository, Integration Directory, and System
Landscape Directory), as well as the Advanced Adapter Engine as a runtime engine. This installation option is
based on AS Java only and you can use it without a standard Process Integration system. You can optionally
deploy additional non-central Advanced Adapter Engines.

1 Note

Regarding the deployment of any other product instance besides Business Process Management (BPM) on
an existing Advanced Adapter Engine Extended (AEX), see SAP Note 1868764 #r.

The following table compares the Advanced Adapter Engine Extended to an SAP Process Integration standard

installation:
Table 10:
Installation Option Advantage Disadvantage
Advanced Adapter Engine Extended o Easy toinstall and to maintain o Connectivity options restricted to
(Java only) adapters of AAE
o Fewer resources needed o Integration processes not availa-
ble

o Only process integration scenar-
jos available as ESR modeling op-
tion

SAP Process Integration o Complete functional range of SAP | © More memory and data storage

Process Integration required

o More cost-intensive

1 Note

User Management
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o |If you deploy non-central Advanced Adapter Engines with Advanced Adapter Engine Extended (AEX),
use the Local User Management (UME Configuration "Java Database") on the non-central Advanced
Adapter Engines. At runtime the non-central Advanced Adapter Engines work independently of the
AEX.

o If you deploy non-central Advanced Adapter Engines with PI, use the ABAP User Management on the
Pl system.

e The AS ABAP system acts as an application and service provider. For Java Web Services, you also require AS
Java. In addition, you require SAP NetWeaver Developer Studio on the client side as a development
environment.

The web service client can be either an SAP or a non-SAP application. For example, an AS ABAP system or a
web browser could act as an application or service consumer.

More Information

See the Help Portal at:

e http://help.sap.com/nw75%%|» Application Help » SAP Process Integration 3
for more information about the concepts and capabilities of SAP Process Integration (PI).

e http://help.sap.com/nw75#|¢ Application Help  Function-Oriented View » Process Integration ¥
Configuring Process Integration After Installation J
for more information about the deployment and the configuration.

You can find detailed descriptions about the different installation options of SAP Process Integration

e SAP Pl Dual Usage Type Installation
e Advanced Adapter Engine Extended

in the SAP Help Portal at http://help.sap.com/nw75# | Application Help % SAP Process Integration » Concepts
» Basics ¥ Installation Options 3

2.2.2.2 Process Orchestration

Use

Process Orchestration provides a tool infrastructure to model and design business processes — from the overall
process flow and the sequence of activities up to the interfaces and data types that are needed to integrate SAP
systems and external systems. It combines the integration capabilities of SAP Process Integration (Advanced
Adapter Engine Extended (AEX) installation option) with the process modeling, operation, and monitoring
capabilities of SAP Business Process Management (BPM). Like AEX, Process Orchestration is based on AS Java
only.
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Integration

The package is based on the following components:

e Components of the Advanced Adapter Engine Extended (AEX), in particular:
o Enterprise Services Repository
Enables you to design integration content like service interfaces and mappings, for example.
o Integration Directory
Configuration tool that allows an integration expert to configure integration content, in particular: One the
one hand, to specify the business communication between business systems and Process Orchestration
and, on the other hand, to specify the connectivity between the BPM process and the Process Integration
runtime.
o Advanced Adapter Engine
Process Integration runtime component that allows you to process XML messages.
® Business Process Management and Business Rules Management engines
Allows an integration expert to model business processes and to execute and monitor the business processes
(BPM-based applications) at runtime.

The involved components are illustrated in the figure below.

Designiconfiguration Time | Runtime :
g
§ Process BPM runtime ST LA e
o3 Composer | Message Start Event | Directory 2
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=4 Event
Process Models | Autornated Activity |
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Figure 6: Components of Process Orchestration
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1 Note

You can obtain Process Orchestration by installation or by adding the corresponding product instances to an
existing SAP NetWeaver system. For latter, both are supported, deployment of BPM on an existing AEX system
and deployment of an AEX on an existing BPM system.

Regarding the deployment of additional product instances besides BPM and AEX, see SAP Note 1868764 #r .
You can deploy non-central Advanced Adapter Engines with Process Orchestration.

Constraints

® Process Orchestration runs on one system. The deployment on more than one system is not supported.

® Process Orchestration can be installed in a cluster. Every node would have an AEX and a BPM instance
running

More Information

See the Help Portal at:

e http://help.sap.com/nw75#|» Application Help » Function-Oriented View  Process Orchestration 3
for more information about the concepts and capabilities of SAP Process Orchestration.

e http://help.sap.com/nw75#|» Application Help  Function-Oriented View » Process Integration ¥

Configuring Process Integration After Installation # Configuring Process Orchestration (PI-CP)
for more information about the deployment and the configuration.

2.2.3 Data Warehousing

The following figure shows the software units that are used for data warehousing.
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Figure 7: Data Warehousing

1 Note

The SAP BusinessObjects products Design Studio, Web Intelligence, Analysis, Crystal reports and Dashboards
require seperate licenses.

With SAP BW, powered by SAP HANA database, SAP offers the SAP HANA database being the in-memory
deployment option for the Data Warehousing use case. In combination with SAP BW 7.5 SPS O (or higher), it
is necessary to use SAP HANA SPS 10 or a higher revision. We recommend using the Revision as of
Datacenter Service Point asdescribedin SAP Note 2165826#% or a higher revision. For more
information on implementation considerations and implementation sequence, see the End-to-End
Implementation Roadmap for SAP BW, powered by SAP HANA on http://service.sap.com/installnw75

|+ Planning 3, and see SAP Note 1600929#% as well as SAP Note 2203650 .

You need Bl Java and the Java-based product instances for specific capabilities only, which are the following:

o  SAP Business Explorer
You need Bl Java, EP Core — Application Portal, and Enterprise Portal for SAP Business Explorer (BEx)
tools and runtime, for example, BEx Web, Information Broadcasting, and Portal Integration.

o BW Administration Cockpit
You need Bl Java, EP Core — Application Portal, and Enterprise Portal if you want to use the BW
Administration Cockpit. The BW Administration Cockpit is part of a business package that is installed in
the SAP Enterprise Portal.

o Wizard-based Configuration of SAP BW (ABAP)
You need AS Java if you want to use the wizard-based configuration for basic configuration settings for
SAP BW (ABAP).
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o UD Connect
You need AS Java if you want to use UD Connect.

o  The Modeling Tools for SAP BW, powered by SAP HANA (BW Modeling Tools) represent a modeling IDE
(Integrated Development Environment) build on top of the Eclipse platform. Its main objective is to
support BW model developers in today's increasingly complex Bl environments by offering state-of-the-
art modeling tools. These tools include integration with SAP HANA modeling and the consumption of
HANA elements in BW Open ODS Views or CompositeProviders with powerful Ul (user interface)
capabilities.

o SAP Business Planning and Consolidation 10.1, version for SAP NetWeaver, makes it possible to create
integrated planning solutions in a BW system, thereby providing high flexibility and usability for specialist
users. A web-based administrator client allows end users to define and monitor planning processes of
their own without having to call on the IT department. For more, please see the master guide of SAP BPC

NW at http://help.sap.com/bopact | Installation and Upgrade Information » Master Guide 3.
Check the licensing conditions for SAP BusinessObjects Planning and Consolidation, version for SAP
NetWeaver.

e [For more information, see

o SAP Community Network: http://scn.sap.com/community/data-warehousing/bw#
o Help Portal: http://help.sap.com/nw75# | Application Help » SAP Business Warehouse 3

o Help Portal: http://help.sap.com/nw75#% |l Application Help ¥ Function-Oriented View ¥ Business
Warehouse 3

1 Note
SAP Strategic Enterprise Management

If you have the SEM-BW add-on installed in your source release, read the following information in the SAP
Community Network: http://scn.sap.com/docs/DOC-30452 .

2.2.4 Mobilizing Business Processes

Use

1 Note

As of SAP enhancement package 1 for NetWeaver 7.3, SAP NetWeaver Mobile is only available as add-on to
SAP NetWeaver. For more information, see SAP Note 1645275 .

The following figure shows the system landscape for Mobilizing Business Processes.
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Figure 8: Enabling Mobile Applications for Occasional Connectivity/Developing Mobile Applications for Occasional Connectivity

o The SAP NetWeaver Developer Studio and an SAP NetWeaver system with product instance DI are only
required for developing mobile applications.
Product Instance Dl is required if multiple developers work with Mobile Web Dynpro Offline. Instead of using
SAP NetWeaver Development Infrastructure, you can also use a non-SAP development infrastructure. For
more information, see the SAP Library at http://help.sap.com/nw75%%|j¢ Application Help » Function-
Oriented View ¥ Solution Life Cycle Management » Using the Development and Production Infrastructure
Development Infrastructure » Concepts » Development Using Optional Development Infrastructure 3

e Optionally you can use SAP Enterprise Portal for accessing the Mobile functions.

e |fyou have installed SAP Enterprise Portal (system with product instance EPC ) in your landscape, you can
use it for managing your SAP NetWeaver Mobile landscape, for example for the administration of clients and
back-end systems and for synchronization. Alternatively, you can use the Data Orchestration Engine
administrator only, which is part of product instance Mobile.

® You can integrate any SAP or non-SAP system as a back-end system.

More Information

For more information, see the Help Portal at

e http://help.sap.com/nw75#|» Application Help » SAP NetWeaver Mobile 3
e http://help.sap.com/nw75¢% |+ Application Help » Function-Oriented View » Mobile 3
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2.2.5 Integrating and Self-Servicing Content with SAP
Enterprise Portal

Use

SAP Enterprise Portal (product instances EPC and EP) provides the core capabilities required to deliver enterprise
content to internal and external users in a uniform and consistent manner, on traditional desktops as well as on
mobile devices. SAP Enterprise Portal, with its role-based access and a modern web front-end, offers a single
point of access to the organization’s structured and unstructured content. Such content includes SAP and non-
SAP information sources, enterprise applications, information repositories, databases and services, regardless of
organizational or technical boundaries.

Product instance EPC is a prerequisite for using the portal add-on capabilities provided by product instance EP.
EPC alone provides a leaner portal installation and implementation where full SAP Enterprise Portal capabilities
are not required.

The following figure shows the software units that are used for Integrating and Self-Servicing Content with SAP
Enterprise Portal.

Clients

Web Browser

Systems with Product Instances Standalone Engines

Web Dispatcher
AS Java Search and Classification (TREX)

Figure 9: Integrating and Self-Servicing Content with SAP Enterprise Portal

1 Note

e Asof SAP NetWeaver 7.0, SAP Knowledge Warehouse (SAP KW) is an integral part of SAP NetWeaver
Application Server. For more information, see the SAP Note 140642236 .

e With SAP Enterprise Portal 7.5 customers can now align and renew their Portal experience with the SAP
Fiori UX (launchpad and apps), while leveraging their existing investment in the Portal (iViews, roles, SSO).
For more information about SAP Fiori, see http://scn.sap.com/docs/DOC-41598#, and about SAP Fiori
UX, see http://scn.sap.com/docs/DOC-61694 Fr .

SAP NetWeaver Master Guide
Planning SAP NetWeaver 7.5 PUBLIC 39


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/140642236
http://help.sap.com/disclaimer?site=http://scn.sap.com/docs/DOC-41598
http://help.sap.com/disclaimer?site=http://scn.sap.com/docs/DOC-61694

More Information

For more information about Integrating and Self-Servicing Content with SAP Enterprise Portal, see the Help Portal
at

e http://help.sap.com/nw75%%|j» Application Help » SAP Enterprise Portal 3
e http://help.sap.com/nw75¢%%|» Application Help ¥ Function-Oriented View ¥ Enterprise Portal 3

2.2.6 SAP Knowledge Warehouse

SAP Knowledge Warehouse (SAP KW) is a solution within SAP NetWeaver that delivers the infrastructure you
need to set up and manage your own enterprise-specific knowledge base in the areas of documentation, training,
and manuals. For project teams and end users, SAP Knowledge Warehouse streamlines training and business
processes, helping to reduce costs. In addition, the ability to reuse, supplement, and continually update SAP
content offers a great savings potential.

SAP KW provides an information repository for companies of all sizes - including global multilingual companies -
with facilities to model structures according to their corporate and market structure.

The following figure shows the software units that are used for SAP Knowledge Warehouse.

Clients

SAP GUI

Web Browser KW Add-On

I I
Systems with Product Instances Standalone Engines

Search and

AS Java AS ABAP Content Server Classification
(TREX)

Figure 10: SAP Knowledge Warehouse

1 Note

e As of SAP NetWeaver 7.0, SAP Knowledge Warehouse (SAP KW) is an integral part of SAP NetWeaver
Application Server. For more information, see the SAP Note 1406422 .
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2.2.7 Custom Application Development (ABAP)

Use

The Application Server ABAP provides the ABAP foundation of SAP NetWeaver. AS ABAP provides a complete
development and runtime environment for ABAP-based applications. It is optimized for the development of highly
scalable business applications.

SAP delivers a vast number of standard Business applications such as the SAP Business Suite and Industry
solutions, on the ABAP platform, meeting the standard enterprise business requirements. However, there are
always certain processes and scenarios in an enterprise, which are customer-specific. These specific processes
and scenarios enable customers to differentiate their business and further leverage their competitive advantage.
To meet these customer-specific needs the Application Server ABAP development and runtime environment
offers extensive tools and services for the development of ABAP based applications. In addition to the
comprehensive development tools support, the Application Server ABAP also offers capabilities for process &
memory administration, multi-user management, database connections and more.

An end to end lifecycle management support equips customers with services & tools, for example for system
landscape management, configuration, transport management, offering support at every stage of the application
lifecycle, from prototype to go-live and thereafter.

Application Server ABAP 7.5 offers various new enhancements for the Custom Application Development (ABAP)
use case. These new enhancements can be broadly categorized into two main areas:

e Core ABAP enhancements
for example for enhancements in the ABAP programing language, Eclipse-based ABAP development
environment and tools.

e SAP HANA based developments
to take advantage of SAP HANA specific features from ABAP such as: New ABAP Profiler to detect code
optimization potential for SAP HANA, Enhanced ABAP List Viewer (ALV) for SAP HANA, ABAP managed
database procedures (AMDP), Core Data Services (CDS).

The data layer of SAP NetWeaver 7.5 is based on Core Data Services (CDS). For SAP NetWeaver 7.5, Core Data
Services have been extended in many different ways (such as annotations, extensions, built-in functions, table
functions) which allows you to develop modern ABAP applications with a compelling user interface based on SAP
UI5. The ABAP developer tools help you to prototype the CDS layer quickly with many built-in templates and
wizards.

The ABAP development and runtime environment makes it possible to develop complex business applications
without having to worry explicitly about technical details such as process or memory administration, multi-user
capability, database connections, or similar issues. These are provided in the basic services of the Application
Server ABAP or are integrated directly in the ABAP runtime. The application development is similarly independent
of the underlying platform. The application server decouples the application coding completely from the operating
system and database that are used. Using ABAP, you can run custom development projects to create and
enhance business functions in the backend, and you can develop applications using various SAP Ul technologies
such as SAP UI5 or Floor Plan Manager (FPM), and Web Dynpro ABAP applications to meet different scenario
requirements.

The Application Server ABAP 7.5 brings with it several innovations and enhancements. The main area of
innovation focus has been on enabling the Application Server ABAP to harness the power of SAP HANA database
for OLAP- and OLTP-based application scenarios. Application Server ABAP 7.5 further on, remains compatible
with traditional relational databases.
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The new core ABAP enhancements focus on providing a rich ABAP developer experience

As shown in the figure below, the system landscape provides additional components for the Custom Application
Development scenario:

e SAP HANA database
e ABAP Development Tools for SAP NetWeaver

Design Time Environment

Client

SAP GUI ABAP Development Tools (Eclipse)

ABAP Platform Layer

Application Server ABAP

Database Layer
Classic DB or SAP HANA DB

Figure 11: Software layers and components that are used in the Custom Application Development scenario

So that optimum benefit can be achieved from running productive Business Suite systems on SAP HANA DB, the
AS ABAP provides support for the migration to SAP HANA DB. A combination of new ABAP code scans as well as
monitoring and analysis tools enables the developer to find ABAP SQL code that has potential for performance
improvement (ABAP for HANA performance optimization).

With ABAP Development Tools for SAP NetWeaver, a new development environment - as an addition to the ABAP
Workbench (SAP GUI) - is at the disposal of the ABAP developer in the classic Custom Application Development
scenario. It is based on the open platform Eclipse and targets a significant increase in development productivity in
all phases of ABAP-based software projects. It combines the strengths of the close integration of development,
test, and quality-assurance tools with the application server AS ABAP; this includes the stable and proven ABAP
Lifecycle Management process - with the advantages of a comfortable and lightweight Eclipse Ul and a
standardized user interaction process.

ABAP Development Tools play a central role in the integration of the SAP HANA repository contents within the
ABAP platform layer. So that native access to models from the SAP HANA repository is possible from within

ABAP, appropriate proxies can be generated as development objects and handled in the same way as other ABAP
repository objects.
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More Information

For more information regarding Custom Application Development (ABAP), see the Help Portal at:

e http://help.sap.com/nw75%%|» Application Help » Function-Oriented View » Application Server »
Application Server ABAP » Application Development on AS ABAP 3

e http://scn.sap.com/community/abape

e http://scn.sap.com/community/netweaver-as

In terms of the implementation of SAP NetWeaver Application Server ABAP 7.5 based on SAP HANA, see the End-
to-End Implementation Roadmap for SAP NetWeaver AS ABAP. This guide is available on the Service Marketplace

at http://service.sap.com/installnw75#|p Planning 3.
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3 Implementing SAP NetWeaver 7.5

The general sequence for the implementation of an SAP NetWeaver system is as follows:

You plan the implementation (such as scope, hardware and software requirements, release restrictions).
You plan the system landscape for the use cases.
You install the components of your SAP NetWeaver system.

M w oo

You configure your systems.

In the following, you find information about the implementation steps for SAP NetWeaver 7.5.

e |[nstallation Procedure [page 44]

e |[nstallation Tool [page 51]

e Configuration of Systems and Follow-Up Activities [page 51]
e System Copy and Migration [page 53]

3.1 Installation Procedure

Use

The installation procedure is divided into the following sections:

Preparation

Installation of required SAP NetWeaver systems
Installation of optional standalone units
Installation of standalone engines

o s wN e

Installation of clients

Procedure

1 Note
Documentation:

Unless stated otherwise, the documentation is available under http://service.sap.com/installnw75 .

1. You prepare the installation procedure.

SAP NetWeaver Master Guide
44 PUBLIC Implementing SAP NetWeaver 7.5


http://help.sap.com/disclaimer?site=http://service.sap.com/installnw75

Table 11:

Tasks

You identify the DVDs and archives required for the installa-
tion of the required software units.

Documentation

You normally obtain the installation media as part of the in-
stallation package from SAP. However, you can also download
installation media from the SAP Software Distribution Center
at http://support.sap.com/swdc .

1 Note

Since the material numbers of the corresponding DVDs,
CDs, and archives may change when new updates become
necessary, we recommend visiting the SAP Software Dis-
tribution Center to make sure that you always use the most
recent version of the indicated data carriers.

For more information, see the section Preparing the Instal-
lation Media in the Installation guide Installing SAP Systems
Based on SAP NetWeaver 7.1 and Higher - Using Software
Provisioning Manager 1.0.

There are specific installation guides for all supported
combinations of technologies (ABAP, Java, or ABAP and
Java), databases, and operating systems.
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Tasks Documentation

Data Warehousing use case only:

Optional: You prepare an SAP system as a data source:

1. The SAP system can be either an OLTP - SAP R/3 sys-
tem (3.1l - 4.6C) or SAP R/3 Enterprise system (Exten-
sion Set 1.10 or higher) or any other SAP system with
PI_BASIS Plug-In.

2. If youwant touse SAP R/3 or SAP R/3 Enterprise as a
data source, make sure that SAP R/3 Plug-In 2004.1 is in-
stalled on the OLTP system: See SAP Note 704564 #%
(R/3 plug-in:P1 2004.1 installation/delta upgrade) and
SAP Service Marketplace at http://service.sap.com/r3-
plug-infe

1 Note

New and extended interfaces for integrating SAP R/3,
SAP R/3 Enterprise, and SAP ERP Central Component
(SAP ECC) are no longer delivered with their own add-
on (SAP R/3 Plug-In). As of SAP ECC 6.0, they are di-
rectly included in SAP ECC. Therefore, this step is not
required for SAP ECC 6.0 or higher.

3. Ifyouwant to install SAP BW on the SAP HANA SPS 10
database, ensure that SAP HANA SPS 10 (minimum revi-

sion:Revision as of Datacenter Service Point

as described in SAP note 2165826 # ) has been properly
installed according to the available SAP HANA on-prem-
ise deployment offerings. For more information, see

o SAP HANA Master Guide on the SAP Help Portal at
http://help.sap.com//hana_platformP‘hrl}
Installation and Update ¥ SAP HANA Master
Guides 4

o SAP Note 1600929 #ir

2. You install the required SAP NetWeaver systems.
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Table 12:

Tasks

You install SAP NetWeaver systems with the required product
instances.

1 Note

There is no installation option for product instances BW
ABAP and Mobile in the installation tool software

provisioning manager 1.0.

e TosetupaSAP BW system, install a system with prod-
uct instance AS ABAP and afterwards install SAP Net-
Weaver 7.4 Bl Content 7.57 or SAP NetWeaver 7.4 Bl
Content Extensions add-on 7.57, if available.

This version of Bl Content add-on will be used for provid-
ing additional data flows that use the new BW features
delivered via SAP NetWeaver 7.4 SPS 05 and higher. So,
if you use the already existing Bl Content Add-on 7.57
(SPO5 and higher), there is nothing much to do. But we
recommend upgrading to the latest available support
package of this Bl Content Add-on 7.57.

e Note for SAP BW on SAP HANA database:

In addition to the SAP NetWeaver Support Package
Stack, we recommend to apply the SAP Notes mentioned
in SAP Note 2203650 #% for the respective Support
Package Stack.

e Tosetup aMobile system, install a system with product
instance AS ABAP and configure it for Mobile.

Documentation

e |nstallation Guide Installing SAP Systems Based on SAP
NetWeaver 7.1 and Higher - Using Software Provisioning
Manager 1.0
There are specific installation guides for all supported
combinations of technologies (ABAP, Java, or ABAP and
Java), databases, and operating systems.

See the following SAP Notes in addition:

e SAPBW:
o 153967#%: (Bl Content Release Strategy)

o 1000822#% : (Overview: SAP Notes for the add-ons
BI_CONT and BI_CONT_XT)

o 1943931#% (Installation/Upgrade for the ABAP-
Add-On BI_CONT 757 / BI_CONT_XT 757).

o 1600929#% (SAP BW powered by SAP HANA DB:
Information)

o 2203650%% (Important SAP Notes for SAP BW
7.50, powered by SAP HANA)

e SAP NetWeaver Mobile:

o 16452754 (Installation of SAP EHP1 for SAP Net-
Weaver Mobile)

If you want to use

e SAP NetWeaver AS ABAP
e SAP NetWeaver AS Java

e SAP Business Warehouse
based on the SAP HANA database, see also the appropriate

End-To-End Implementation Roadmap, which is also available
on the Service Marketplace at http://service.sap.com/

installnw75#% | Planning 3.

SAP Kernel Update

Make sure that you apply the latest kernel as described in the
Installation Guide.

e |nstallation Guide Installing SAP Systems Based on SAP
NetWeaver 7.1 and Higher - Using Software Provisioning
Manager 1.0
There are specific installation guides for all supported
combinations of technologies (ABAP, Java, or ABAP and
Java), databases and operating systems, available at:

http://support.sap.com//sltoolset&-l} System

Provisioning ]
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Tasks

Support Package Stack Update

We recommend that you always apply the latest Support
Package Stack.

Documentation

You can apply Support Package Stacks on top of SAP Net-
Weaver 7.5 and higher by using the Software Update Manager
tool. See the Update Guide — Update of SAP Systems Using
Software Update Manager 1.0 <SPxx>.

The guide and more information are available at http://serv-

ice.sap.com//maintenancenw75 .

Process Integration:

After an installation of SAP Process Integration, you carry out
the configuration wizard-assisted basic configuration to con-
figure at least the connection to the System Landscape Direc-
tory (SLD) before you perform the support package installa-
tion step.

Further Configuration Wizard-assisted basic configuration
steps can be performed after the SAP Solution Manager Con-
figuration and the Support Package Installation.

Configuration documentation on SAP Help Portal at:

http://help.sap.com/nw75fhr|} Application Help >
Function-Oriented View # Process Integration > Configuring

Process Integration After Installation 3

You install the SAP Library in your system.

Installation Guide Installing SAP Library for SAP NetWeaver
Based Systems - Using Software Provisioning Manager 1.0

3. You install optional standalone units.
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Table 13:

Tasks

You can find the following software units in the installation tool
software provisioning manager 1.0 under Optional

Standalone Units:

e Advanced Adapter Engine (PI-AF)
e Advanced Adapter Engine Extended (PI-AEX)

® Process Integration and Orchestration Package (PI-CP)

Documentation

Installation Guide Installing SAP Systems Based on SAP Net-
Weaver 7.1 and Higher - Using Software Provisioning Manager
10

There are specific installation guides for all supported combi-
nations of technologies (ABAP, Java, or ABAP and Java), da-
tabases and operating systems, available at: http://

support.sap.com//sltoolset® | System Provisioning 3.

You can find additional configuration information on SAP Help
Portal at: http://help.sap.com/nw75fb’|} Application Help
» Function-Oriented View * Process Integration

Configuring Process Integration After Installation } Choose:

o |p Configuring Process Integration (Pl) Dual-Stack b

Basic Configuration for SAP Process Integration (Pl)
Configuring the Non-Central Advanced Adapter Engine

(PI-AF) 34

o |p Configuring Advanced Adapter Engine Extended (PI-
AEX) ¥ Basic Configuration for SAP Pl Advanced Adapter
Engine Extended ¥ Configuring the Non-Central
Advanced Adapter Engine (PI-AF) for AEX 1

o | Configuring Process Orchestration (PI-CP) 4

4. You install the standalone engines.

Table 14:

Tasks

Web Dispatcher

Documentation

Installing Web Dispatcher for SAP Systems Based on SAP Net-
Weaver 7.1 and higher using Software Provisioning Manager
10

Standalone Gateway

Installing Gateway for SAP Systems Based on SAP NetWeaver
7.1and higher using Software Provisioning Manager 1.0

liveCache

Installing SAP liveCache Using Software Provisioning Manager
1.0: <Operating System>

Search and Classification (TREX)

SAP NetWeaver Search and Classification (TREX):
e |nstallation Guide — SAP NetWeaver Standalone Engine
Search and Classification (TREX) 7.1 Single Host

e |nstallation Guide — SAP NetWeaver Standalone Engine
Search and Classification (TREX) 7.1 Multiple Hosts
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Tasks

Content Server

Documentation

Installation Guide — SAP Content Server 6.40 available
at:http://service.sap.com/instalInw70¢r|} Installation —
Standalone Engines }

Adapter Engine Java SE

SAP Help Portal at http://help.sap.com/nw75
|} Application Help > Function-Oriented View > Process
Integration > Adapter-Engine (Java SE) > Installation ]

5. You install the clients.

Table 15:

Tasks

SAP GUI for Windows

Business Explorer

During the installation of SAP GUI, you can choose to install
the Bl add-on for the SAP Business Explorer.

Note that SAP GUI for HTML and SAP GUI for Java do not
have all the capabilities of SAP GUI for Windows. BEx Query
Designer, BEx Analyzer, and Uls with network controls are not
supported with SAP GUI for HTML and SAP GUI for Java.

Adobe LiveCycle Designer

Documentation

SAP Front End Installation Guide

ABAP Development Tools for SAP NetWeaver (ADT)

Installation Guide ABAP Development Tools for SAP NetWea-
ver

ADT can be downloaded from the SAP Software Download

Center at https://support.sap.com/swdc

BW Modeling Tools

Installation guide BW Modeling Tools

SAP NetWeaver Business Client

SAP Help Portal at http://help.sap.com/nw75#%|# System
Administration and Maintenance Information > Technical
Operations for SAP NetWeaver > Technical Operations for
SAP NetWeaver Business Client }

Mobile Client SAP Help Portal at http://help.sap.com/nw75#
|} Application Help > Function-Oriented View > Mobile >
Configuring SAP NetWeaver Mobile ¥ Installing Mobile-
Specific Software Units 4
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Tasks Documentation

SAP Enterprise Services Explorer Tool for Microsoft .NET For a detailed description of functions and features, see
http://scn.sap.com/docs/DOC-17627 .

SAP BusinessObjects clients (SAP Crystal Reports, Dash- See the installation guides at: http://help.sap.com/bobifr

boards, Analysis, Web Intelligence)

3.2 Installation Tool

For the new installation of an SAP system including an enhancement package you use the standard installation
tool software provisioning manager 1.0.The software provisioning manager performs software
provisioning processes such as installation, uninstallation, system copy, or system transformation.

Software provisioning manager is the successor of the product- and release-specific delivery of provisioning tools,
such as saPinst. Before you perform an installation or system copy, we recommend that you always download
the latest version of the software provisioning manager, which is part of the Software Logistics Toolset (SL
Toolset for short). This way, you automatically get the latest sSaAPinst version including latest fixes in the tool and
supported processes.

See also the information on the SAP Service Marketplace at http://support.sap.com/sltoolsetf | Software
Logistics Toolset 1.0 » System Provisioning 3.

3.3 Configuration of Systems and Follow-Up Activities

Before you can start working with your SAP NetWeaver installation, you have to adapt it to your needs.

Configuration

The SAP Solution Manager contains descriptions of all configuration tasks, and leads you to automated
configuration procedures, where available.

1. Tobe able to use SAP Solution Manager for configuring your systems, you have to import the latest available
Support Package for the SAP Solution Manager Implementation Content (add-on ST-ICO). For more
information, see SAP Note 631042« (Release strategy for Implementation Content (ST-ICO)).

SAP Solution Manager Implementation Content is available on SAP Service Marketplace at http://
service.sap.com/swdc# | Support Packages and Patches » A-Z Index # 'S’ » SAP Solution Manager ¥
<Release> » Entry by Component » Solution Manager ABAP Stack » ST-ICO<version> 1.

2. Toaccess the configuration tasks, you create a project and a project structure in SAP Solution Manager. In

the configuration phase, you select configuration structures with pre-delivered SAP content for your project.
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1

You can either access the configuration task in the configuration structure or create a printable configuration
guide.
For more information, see:

o SAP Library at http://help.sap.com# | Application Lifecycle Management » SAP Solution Manager »
<release> » Application Help ¥ Solutions Implementation » Implementation/Upgrade Work Center
Configuration J

o http://support.sap.com# | Support Programs & Services » SAP Solution Manager 3 or http://
support.sap.com/solutionmanager .

o http://support.sap.com/solutionmanager®|p Knowledge Transfer » How-To Documents ¥ How to
Create a Configuration Guide using SAP Solution Manager 3

Some configuration activities are automated, that is they are performed using automation tools such as the
configuration wizard. The automation tools support you in performing technical configuration tasks in an
automated way and thus accelerate and simplify the setup of your systems after installing. For more

information, see the Automation Tools node in the configuration structure. In case of ABAP systems, you can
use executable configuration files (IMG activities).

Note

Accessing Use Case information in SAP Solution Manager

You can use the business process repository browser (BPR browser) in SAP Solution Manager at https://
implementationcontent.sap.com/bpr# to access instantly information about the SAP NetWeaver 7.5 use
cases you want to implement:

Choose |lF Business Process Repository # Solutions/Applications » SAP NetWeaver 3 to access centrally
all SAP NetWeaver 7.5 use cases.

Choose |[F Business Process Repository » Solutions/Applications » SAP Technology » ->End-To-End Use

Cases dto access end-to-end implementation information about Application Life-Cycle Management and
Enterprise Data Warehousing.

Process Integration

Instead of creating your configuration guides with the SAP Solution Manager, you can also find the
configuration information in the SAP Help Portal. Access the SAP NetWeaver 75 Library at: http://

help.sap.com/nw75¢% | Application Help » Function-Oriented View # Process Integration » Configuring

Process Integration After Installation .

1.

52

For configuring the Process Integration (PI) dual usage type installation, choose |+ Configuring Process
Integration (Pl) Dual Stack » Basic Configuration for SAP Process Integration (Pl) 4.
o For configuring the Non-Central Advanced Adapter Engine (PI-AF) for Pl dual usage type installation,
choose |» Configuring the Non-Central Advanced Adapter Engine (PI-AF) 3.
For configuring the Advanced Adapter Engine Extended (PI-AEX), choose | Configuring Advanced Adapter
Engine Extended (PI-AEX) » Basic Configuration for SAP Pl Advanced Adapter Engine Extended .
o For configuring the Advanced Adapter Engine Extended (PI-AF) for AEX, choose | Configuring the
Non-Central Advanced Adapter Engine (PI-AF) for AEX .
For configuring the Process Orchestration (PI-CP), choose |* Configuring Process Orchestration (PI-CP) 3.
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3.4 System Copy and Migration

Use

At several stages in the lifecycle of your SAP solution, you will face the requirement to perform a system copy or a
migration. For example, SAP recommends that you perform a system copy to create test, demo and training
systems. Also, if you need to change your operating system and/or database, you have to perform a migration of
your SAP system.

For this, SAP is offering system copy and migration services that enable you to create consistent copies of your
SAP systems, flexibly adapted to your needs - be it an SAP system distributed to several hosts, a high-availability
system or a system on a rather exotic operating system/database combination.

More Information

e Foranintroduction into system copy and migration, see http://scn.sap.com/docs/DOC-8324#k in the SAP
Community Network.

e System copy guides are available on SAP Service Marketplace at http://service.sap.com/installnw75# .

e Alternatively, you can copy your system with a completely automated end-to-end framework available with
the SAP NetWeaver Landscape Virtualization Management <Release>, Enterprise Edition. For more
information, see the SAP Help Portal at http://help.sap.com/nwivm# .
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A Appendix

A.l1 Additional Information for Implementing SAP NetWeaver

The following table contains links to information available on SAP Service Marketplace or in the SAP Library which
is relevant for implementing SAP NetWeaver:

Table 16:

Location on SAP Service Marketplace or in SAP Library

The latest version of the installation and upgrade guides for http://service.sap.com/instguidesnw75
SAP NetWeaver 7.5

System Copy Guides http://service.sap.com/installnw75

Information about security SAP Security Guide: See the SAP Library at http://
help.sap.com/nw75fb’|} Security Information > Security
Guide 3.

Information about the technical operation of SAP NetWeaver | Technical Operations Manual: See the SAP Library at http://
help.sap.com/nw75fblb System Administration and
Maintenance Information > Technical Operations for SAP

NetWeaver }

Information about SAP NetWeaver Support Package Stacks http://support.sap.com/sp-stacks

Information about SAP NetWeaver Capabilities e http://scn.sap.com/community/netweaver

e http://scn.sap.com/docs/DOC-8287 ¥

° http://help.sap.com/nw75fb’|} Application Help }

SAP Solution Manager Guides All SAP Solution Manager related guides, such as
e Master Guide

e Configuration Guide

e Security Guide Master Guide

e Upgrade Guide

e Solutions Operations Guide

are available at:http://service.sap.com/instguidesfblb
Installation & Upgrade Guides > SAP Components > SAP

Solution Manager > <Release> }
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Content Location on SAP Service Marketplace or in SAP Library

Information about Maintenance Tools: Maintenance Planner | See SAP Community Network at http://wiki.scn.sap.com/
and Maintenance Optimizer wiki/x/VIwgCw e

A.2 Description of Software Units

The following sections provide more details about product instances, standalone engines, optional standalone
units and clients of SAP NetWeaver.

1 Note
Usage Type, Technical Usage, and Product Instance

The term product instance replaces the terms usage type and technical usage for SAP systems based on SAP
NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731# .
Note that there is no terminology change for older releases and all mentioned terms can be used as synonyms.

Caution
Uninstalling additional product instance

Note that it is not possible to uninstall additional product instances and that this is also not supported by SAP.

A.2.1 Systems with Product Instances

Installation Options for SAP NetWeaver Systems With Product Instances

The standard SAP installation tool software provisioning manager 1.0 offersthe following options for
installing SAP NetWeaver systems with product instances:

e Application Server ABAP
This installation option installs an Application Server ABAP which is the basis for product instance BW ABAP
and Mobile.

® Process Integration
This installation option installs an ABAP+Java dual stack systems with product instance Process Integration
and all dependent product instances.

e Application Server Java
This installation option leads you to a selection screen where you can select those product instances that you
want to install in addition to Application Server Java.
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Adobe Document Services (ADS)

The following figure gives an overview of all available Java product instances and their dependencies:

Central Process Enterprise
Scheduling Services
(JOB-SCHED) Repository (ESR)

Business Process
Management and
Bl Java (Bl) Business Rules
Management
(BPM)

Composition

Environment

Platform (CE-
ENV)

Enterprise Portal

EP Core — Development
Application Portal Infrastructure
(EPC) ((2))]

PDF Export

Adobe Document
Services (ADOBE)

Application
Server Java
(BASIC)

Figure 12: Java Product Instances

For more information and installation instructions, see the SUM guide for Java: Update Guide — Updating SAP
Systems Using Software Update Manager, for: Java, section Installing Additional Product Instances in an

Existing SAP System.

Apart from the product instances described here, there are some discontinued product instances that you
can still install for compatibility reasons. For more information, see Compatibility Product Instances [page

72].

Adobe Document Services is a set of runtime services that provide a range of form and document creation and
manipulation functions such as:

Converting XML form templates (created using Adobe LiveCycle Designer) to PDF and various print formats

Setting Adobe Reader rights to enable users to fill in and annotate forms, save and print them locally, and
include digital signatures for authentication using the free Adobe Reader software

Extracting data from SAP applications into Interactive Forms and transferring form data back into SAP

applications using XML

Dependencies

Adobe document services depends on Application Server Java.

Functional Units

Adobe Document Services comprises the identically named functional unit.

Application Server ABAP (AS ABAP)

SAP NetWeaver Application Server for ABAP provides a complete development and runtime environment for
ABAP-based applications. It is optimized for the development of highly scalable business applications. The ABAP
development environment is used both for developing completely new applications and extending and modifying
SAP standard applications for customers. The entire, powerful infrastructure of the Application Server for ABAP
can be used, which even supports the creation of the most complex applications by large groups of developers.
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Application Server Java (BASIC)

AS Java is used to provide the Java foundation of SAP NetWeaver using the Java Engine, a Java EE-compliant
application server for running enterprise applications. In addition to the pure Java EE standard technologies, the
Java Engine implements complementary technologies such as Web Dynpro or Web Services.

Dependencies

AS Java can be combined optionally with other Java-based product instances in one system.

Functional Units

Application Server Java comprises the following functional units:

Table 17:

Functional Unit

CM Services (Change Management Services)

Description

CM Services help you to manage your Java development.
They provide services for creating development configura-
tions, for importing and exporting, and for the deployment to
runtime systems. CM Services enable you to set up team de-
velopment with centrally managed development configura-
tions. It also supports the automated deployment of build re-
sults on to central runtime system. The import and export
service enables you to import and export Software Compo-
nent Archives (SCAs) of a development configuration. When a
transport system is needed, a development configuration can
be integrated into the Change and Transport System (CTS+).
To use CM Services, product instance Dl is required.

Java Data Archiving

Java Data Archiving provides APIs to allow Java applications

to connect to the XML Data Archiving Service for data archiv-
ing solutions. Java archiving is required for Java applications

with a large volume of retention-relevant data.

Java Foundation

This is the Java foundation of SAP NetWeaver. Among its ca-
pabilities is the JEE Engine, a J2EE-compliant application
server for running enterprise applications. In addition to the
pure JEE standard technologies, the JEE Engine implements
complementary technologies, such as Web Dynpro or Web
Services, that are targeted at supporting large-scale, real-
business application development projects.

Services Registry

The Services Registry is a registry for Web services. Located
centrally within an SOA landscape, it contains entries for all
services and service definitions in that landscape. The regis-
tered services are classified using semantic-rich classification
systems to enable the browsing of services by classification.
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Functional Unit Description

System Landscape Directory The System Landscape Directory (SLD) of SAP NetWeaver
serves as a central information repository for your system
landscape. A system landscape consists of hardware and soft-
ware components that depend on each other with regard to
installation, software updates, and demands on interfaces.
The information in the SLD is used by various SAP tools.

XML Data Archiving Service The XML Data Archiving Service (XML DAS) enables data to
be stored using the WebDAV Storage Interface for the ILM
Solution from SAP as certified in the interface BC-ILM. It al-
lows both XML-sensitive storage used for JAVA Archiving or
XML Archiving (see corresponding Functional units) and ILM
aware archiving used in SAP NetWeaver ILM.

Bl Java (BI)
Bl Java provides the Java runtime for several BW capabilities.
Dependencies

Bl Java requires AS Java, EP Core — Application Portal, and Enterprise Portal in the same system. Usually,
scenarios running on product instance Bl Java also require product instance BW ABAP. While installing Bl Java,
the required product instances are installed automatically. After configuring Bl Java, you do not need to perform
further steps in AS Java, EP Core — Application Portal, and Enterprise Portal.

Functional Units
Bl Java comprises the identically named functional unit.
Business Process Management and Business Rules Management

Business Process Management supports the process collaboration and creation of new innovative business
processes based on standardized core processes. SAP Business Process Management enables collaborative
composition of executable business processes based on a process model. Clearly defined business rules can be
incorporated into processes from the outset. The tight integration with Business Rules Management enables
business users with no coding skills to create and modify rules using decision tables.

With Business Rules Management you can author, execute, and manage business rules. The following key
features are offered by Business Rules Management:

® [nference-based rule engine implementing RETE algorithm

e Support of different rules formats (declarative rules, decision table and flow rules)

e Rules Manager: a Web Dynpro Java based rules maintenance tool for business users
e Versioning and tracking changes of business rules

e Qut-of-the-box Web service generation for rule sets

e Rules testing in the rules composer (NWDS)

e Public API for rules execution

e Tighter integration with Business Process Management

Dependencies
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Business Process Management and Business Rule Management requires AS Java and Composition Environment
Platform in the same system.

Functional Units

Business Process Management and Business Rule Management comprise the following functional units:

Table 18:
Functional Unit Description
Process Server Contains the function for Business Process Management
Rules Server Contains the functions for Business Rules Management

Business Warehouse ABAP (BW ABAP)

Business Warehouse provides the infrastructure for the following functions:

e Data warehousing

e Various analytical technologies and functions

e Business planning functions

e \Web-based and Excel-based reporting, analysis, and planning

e [nformation broadcasting to distribute BEx applications via various channels either as precalculated
documents with past data, or as links with live data

e QOpen analysis interfaces that make available various interfaces for connecting front-end tools of third-party
providers

Dependencies

BW requires AS ABAP as a prerequisite in the same system.

1 Note

For product instance BW, there is no installation option in the software provisioning manager 1.0.
Instead, install AS ABAP with software provisioning manager 1.0 andthen SAP NetWeaver 7.4 B
Content 7.57 or SAP NetWeaver 7.4 Bl Content Extensions add-on 7.57. This version of Bl Content add-on will
be used for providing additional data flows that use the new BW features delivered via SAP NetWeaver 7.4 SPS
05 and higher.

If you use the already existing Bl Content Add-on 7.57 (SPO5 and higher), there is nothing much to do. But we
recommend upgrading to the latest available SP of this Bl Content Add-on 7.57

Central Process Scheduling by Redwood (JOB-SCHED)

SAP Central Process Scheduling adds powerful cross-component scheduling functionality to the integration
capabilities of SAP NetWeaver. SAP Central Process Scheduling has the following key characteristics:

e Centrality
There is only one central instance of this scheduler which takes control over all background processes in the
entire landscape and allows for cross system scheduling.

e FEvent-Driven Scheduling
Dependencies between background processes can be defined not only time based but also event based.

e Real-Time Execution
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Allinformation about jobs is stored centrally and transferred to the remote systems immediately before job
submission.

For more information, see SAP Developer Network at http://scn.sap.com/community/cps-by-redwood .
Dependencies

SAP Central Process Scheduling requires Application Server Java in the same system.

Functional Units

SAP Central Process Scheduling comprises the functional unit Integrated Central Process Scheduling by
Redwood.

Composition Environment Platform (CE-ENV)

The Composition Environment Platform provides a toolset and runtime for efficiently developing, running, and
managing composite applications based on SOA principles. It builds upon proven technologies that have been
enhanced and integrated to provide greater functionality and flexibility. The Composition Environment Platform
offers you the following capabilities:

e User interface (Ul) development: SAP NetWeaver Web Dynpro and SAP NetWeaver Visual Composer
Web Dynpro and Visual Composer are SAP's standard Ul technologies based on the Model View Controller
(MVC) for developing user interfaces. Web Dynpro Java or Visual Composer applications are developed within
the SAP NetWeaver Developer Studio using a model-driven approach that minimizes manual Ul coding and
uses visual tools to design and reuse components.

e Java business object modeling

e Service Simplification and Composition
A graphical modeling capability simplifies and adapts Complex Services for easy consumption in Composition
Environment. This greatly eliminates the need to write code for simplification and data mapping.

Dependencies
Composition Environment Platform requires Application Server Java in the same system.
Functional Units

Composition Environment Platform comprises the following functional units:

Table 19:
Functional Unit Description
Composition Environment Platform Composition Environment Platform is the foundation for

building and running composite applications.

ECM integration core Enterprise Content Management (ECM) Integration Core facil-
itates the provision and consumption of Enterprise Content
Management services using standardized interfaces. There-
fore, it enables business applications to consume core ECM
services provided by SAP as well as extended ECM services
provided by partners and third-party vendors leveraging their
ECM product offering. Besides the core runtime components,
this functional unit contains the service provider interface
(SPI) for exposing ECM services as well as the application pro-
gramming interface (API) for making use of these services.
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Functional Unit

ECM Integration Services

Description

ECM Integration Services offer additional services on top of
ECM Integration Core functional. These supplementary serv-
ices such as the server for World Wide Web Distributed Au-
thoring and Versioning (WebDAV) can be leveraged by appli-
cations on top of the already exposed ECM services of the
connected service providers.

Visual Composer

Visual Composer is a model-driven development tool used to
create Ul screens and Portal content using a drag-and-drop
graphical environment, without the need to write code. Using

Visual Composer you can create standalone applications such

as form views and dashboards or Ul screens, such as Web
Dynpro screens. Visual Composer also provides Portal Con-
tent Modeling capabilities for generating roles, pages, iViews
and other content for the SAP NetWeaver Portal.

Portal

Provides basic SAP NetWeaver Portal capabilities excluding
the Web Page Composer capabilities, the data statistics tools
of Portal Activity Reports, and the Activity Data Collector.

Universal Worklist

Offers users unified and centralized access to their work and
relevant information from within the portal. It collects tasks
and notifications from multiple provider systems — Business
Workflow, Collaboration Task, Alert Framework, and KM Re-
cent Notifications — and displays them in a single list.

Development Infrastructure (DI)

Development Infrastructure provides an infrastructure for developing Java-based applications on the SAP
NetWeaver platform and enables versioning of source code, build and lifecycle management of these applications.

Dl takes care of all parts of the development process :

1. Version control system for central management of source code: The Design Time Repository (DTR) is a

distributed version control system used in SAP NetWeaver Development Infrastructure to manage source
code in development and lifecycle management processes.

. Central build and archive management: The Component Build Service (CBS), gives developers access to the
latest archive versions in a central archive storage and a central build triggered by developers or central
lifecycle management processes.

. Central landscape and transport management: CM Services enables you to set up team development with
centrally managed development configurations. It also supports the automated deployment of build results
on a central runtime system. The import and export service allow you to import and export Software
Component Archives (SCAs) of a development configuration. If a transport system is needed, a development
configuration can be integrated into the enhanced Change and Transport System (CTS+).

You can also use the Change Management Service (CMS), which gives administrators a central service to set
up development landscapes for all development tasks and manage all transport processes for these tasks in
the same Ul. However, note that CMS is planned to be replaced by the CM Services in future releases.
Therefore, we recommend using CM Services.

Dependencies
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e Dlrequires AS Java as a prerequisite in the same system. Optionally, it can be combined with other product
instances in one system. However, depending on the size of the development project and the number of
active developers, DI should use a dedicated system. For further details, see SAP Note 737368 .

You can run the development infrastructure on an AS Java separately from the rest of your runtime systems
in the system landscape for improved scalability.

If you use a development infrastructure, you have to install the Developer Studio feature SAP NetWeaver
Developer Studio Development Infrastructure Client.

Functional Units

DI comprises the functional unit SAP NetWeaver Development Infrastructure providing the above-mentioned
functions.

Enterprise Portal (EP)

Enterprise Portal (EP) provides users with a single, uniform point of access to the applications, services, and
information they need for their daily work. Moreover, the Portal offers business users the features to easily create
and manage portal pages and generate their own content using the following capabilities:

e KM and Web Content Capabilities
EP provides basic document management capabilities and content services within SAP Enterprise Portal
(KM). KM provides the basic capabilities that customers need to run their scenarios, as well as an extension
framework for custom implementations.
These KM capabilities are also integrated into the Web Page Composer environment to enable flexible Web
content management scenarios, bringing relevant information from user-generated content and business
applications together in the portal.

e Portal Add-On with Forums and Wiki Capabilities
On top of EP, you can install the portal add-on including the forums and the wiki application.
The forums application provides a comprehensive range of discussion features, which are particularly
suitable for community scenarios. Forums typically focus on a specific purpose such as support or human
resources or they might offer customers a place to trade product tips and solutions. Intuitive user interfaces
make it easy for users to ask questions, share information, post announcements to the community, escalate
questions to experts, and to receive updates on posted comments. Users can create draft versions of their
postings, exchange private e-mails with other forum users, and vote in polls.
Wikis provide a framework to easily share and contribute knowledge and information in an intuitive way within
the company. They give employees, customers, suppliers, and partners a framework to collaborative writing,
and help save time by making ideas available, sharing knowledge, and managing related information.

e SAP Fiori
With SAP Enterprise Portal 7.5 customers can now align and renew their Portal experience with the SAP Fiori
UX (launchpad and apps), while leveraging their existing investment in the Portal (iViews, roles, SSO).
For more information about SAP Fiori, see http://scn.sap.com/docs/DOC-41598#% , and about SAP Fiori UX,
see http://scn.sap.com/docs/DOC-61694 ¥ .

Dependencies

EP requires EPC and AS Java as a prerequisite in the same system. Optionally, it can be combined with other
product instances in one system.

Functional Units
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Enterprise Portal comprises the following functional units:

Table 20:

Functional Unit Description

Knowledge Management Enables portal users to distribute, access, and manage un-
structured information within an organization in a heterogene-
ous repository landscape. Capabilities include collaborative
document authoring and publishing, version management,
search and navigation with taxonomies, automated classifica-
tion and subscription, and more.

Collaboration Brings users, information, and applications together to ensure
successful cooperation and interaction in the portal. These
tools include collaboration rooms, instant messaging, e-mail,

and calendar integration.

Enterprise Services Repository (ESR)

The Enterprise Services Repository (ES Repository) provides a central place where enterprise service definitions
are modeled, stored, and maintained. It supports SAP's concept of building services based on the process
component modeling methodology. The ES Repository offers the following features:

e Support of governed definitions of SOA assets (such as services and data types).

e Support of widely adopted open standards including Web Services and UDDI.
The ES Repository supports SAP-defined Global Data Types based on the Core Component Technical
Specification standards (stack) (CCTS standards (stack)).

e Basis for enabling easy access to enterprise services - described with rich business classifications - when
developing composite applications and business processes.

Dependencies
Enterprise Services Repository requires Application Server Java in the same system.
Functional Units

Enterprise Services Repository comprises the identically named functional unit providing the above mentioned
capabilities.

EP Core — Application Portal (EPC)

EP Core — Application Portal (EPC) provides the basic portal capabilities for SAP NetWeaver. It provides a uniform
entry point to content and applications in a consistent, role-based manner. It offers a single point of access
through a Web front end to SAP and non-SAP information sources, enterprise applications, information
repositories, databases and services across organizational and technical boundaries — all integrated into a single
user experience. EPC alone provides a leaner portal installation and implementation where the full enterprise
portal capabilities (such as knowledge management tools) are not needed.

The EPC product instance contains the following capabilities that will help you manage your content and
processes:

e The core portal capabilities include various tools and service for managing portal content, users, and
connections to connected systems such as Single-Sign-On, tools for application integration, roles and
permissions, changing the portal look and feel with the new Ajax Framework, and lifecycle management
(transport).
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® |Integration of several SAP Enterprise Portals and third-party portals into one harmonized SAP Enterprise
Portal acting as the single point of access to all the business related applications and services in the
organization.

e \Web Page Composer (WPC): this is an integral part of EPC providing powerful capabilities for business users
to easily create and manage enriched portal pages. Web Page Composer supports professionals creating
interactive portal pages.

Dependencies
EPC requires AS Java as a prerequisite in the same system.
Functional Units

EP Core — Application Portal comprises the following functional units:

Table 21:
Functional Unit Description
Portal Provides basic SAP Enterprise Portal capabilities
Universal Worklist Provides the Universal Worklist Capabilities

Mobile

Product instance Mobile is used to enable field personnel to participate in a business process in an “occasionally
connected” mode. Occasionally connected means that a direct connection (using WLAN or GPRS) between the
mobile device and back end is only established at certain times — at synchronization points, when the Mobile
Server (that is, the system with product instance Mobile) and Mobile Client exchange data in order to keep the
server and client updated. This enables the user to perform process tasks completely independently from the
back-end system, which is extremely helpful if a steady connection cannot be guaranteed or might be too
expensive. To realize this product instance, an intelligent application needs to run on each device containing a
user interface, business logic, and data handling. Mobile includes the Data Orchestration Engine (DOE), an ABAP-
based message-oriented middleware. The Data Orchestration Engine consists of the following:

e Adesign time tool for defining data objects and the distribution of data.
e Aruntime to replicate, synchronize and distribute data between the components of the system landscape.
This includes, for example, messaging, filling queues, and sending data to the back end.

Dependencies

Mobile is not an installable software unit. As of SAP enhancement package 1 for SAP NetWeaver 7.3, SAP
NetWeaver Mobile is available as add-on. To set up a Mobile system, you install and configure AS ABAP. On top of
the AS ABAP system, you install and configure the SAP NetWeaver Mobile add-on separately.

PDF Export

With PDF Export, you can create print versions of lists that are displayed using ALV for Web Dynpro for ABAP
(SAP List Viewer) and ALV for Web Dynpro for Java.

Dependencies
PDF Export depends on Adobe Document Services and AS Java.
Process Integration (PI)

Pl consists of core components that model, design, automate, and integrate processes in one or more application
systems. For the integration of internal and cross-company processes, Pl is used to incorporate all the functions

SAP NetWeaver Master Guide
64 PUBLIC Appendix



of what was formerly known as Exchange Infrastructure (XI). In addition, Pl contains core components for cross-
component Business Process Management (ccBPM) for application-embedded and application-unbounded
processes.

Dependencies

Plrequires AS ABAP, AS Java, Pl Adapter Engine, and Enterprise Services Repository as a prerequisite in the
same system.

For installing PI, it is mandatory to have a dedicated Pl system. This applies to development, quality, and
production landscapes. It is a prerequisite that no other system in your system landscape has a higher release
and enhancement package level than the Pl system. If you want to upgrade or install an application in your system
landscape, you first have to make sure that the current release and enhancement package level of the Pl system is
on the same level - if required, you have to upgrade the Pl system first to the new or a higher release. In a
dedicated PI system, this can be accomplished with a minimum of downtime. Also, the Pl system would not be
affected by the downtime of other product instances running in the same system.

Functional Units
Process Integration comprises the functional unit SAP Process Integration.

Restrictions for Systems with Multiple Product Instances

e |f you have one system with multiple product instances, be aware that we do not provide standard tools for
separating these product instances and distribute them to multiple systems at a later stage. For example, if
you have a system with product instances A and B, you are not able to migrate it with SAP standard tools into
two systems, one with product instance A only and the other with product instance B only.

In addition, we do not provide standard tools for merging multiple systems with different product instances
into one system with multiple product instances at a later stage. If you want to perform these tasks, you
require specific project support. The only exception is the dual-stack split procedure that offers to split an
optional dual-stack system into two separate systems: one based on AS ABAP, the other one based on AS
Java. For more information about the dual-stack split, see http://scn.sap.com/docs/DOC-25162 # .

The following figure shows that SAP standard system copy and migration tools do not support you in
separating or merging systems with product instances:

Figure 13: Separating systems with product instances are not supported with SAP standard system copy and migration
tools
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Figure 14: Merging systems with product instances are not supported with SAP standard system copy and migration tools

e Although you can use one system for multiple product instances, client restrictions apply to product instance

BW ABAP. For BW ABAP, you should reserve a dedicated client for reporting purposes. In this client, activate
the SAP NetWeaver Bl Content Add-On as required.

A.2.2 Optional Standalone Units

Advanced Adapter Engine (Pl Adapter Engine)

You use the Advanced Adapter Engine to connect to SAP systems (RFC adapter, IDoc Adapter, and ABAP
proxies) and external systems. You use the various adapters in Pl Adapter Engine to convert XML- and HTTP-
based messages to the specific protocol and format required by these systems, and the other way around.

You can use the following adapters:

e RFC Adapter

e SAP Business Connector Adapter

e File/FTP Adapter

e JDBC Adapter

e JMS Adapter

e SOAP Adapter

e Marketplace Adapter

e Mail Adapter

e RNIF Adapter

e CDIX Adapter

e |Doc Adapter (Advanced Adapter Engine) (adapter type IDOC_AAE
e HTTP Adapter (Advanced Adapter Engine) (adapter type HTTP_AAE)

You can use the Advanced Adapter Engine which is included in the Pl system as a central adapter engine.
Optionally, for performance reasons, you can install a non-central Advanced Adapter Engine on a separate host.

Dependencies

The Advanced Adapter Engine requires AS Java as a prerequisite in the same system. These product instances
are automatically installed when you install the Advanced Adapter Engine.
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Functional Units
The Advanced Adapter Engine comprises the functional unit Advanced Adapter Engine.
Advanced Adapter Engine Extended

The installation option Advanced Adapter Engine Extended (AEX) consists of core components to model, design,
automate, and integrate processes in one or more application systems. The Advanced Adapter Engine Extended
provides the following capabilities:

e Connectivity capabilities of the Advanced Adapter Engine (AAE)

e Design and configuration tools to set up scenarios that are based on the AAE. In particular, for design and
configuration you can use the ES Repository and the Integration Directory. The Integration Directory installed
with AEX contains a subset of configuration options required for the configuration of message processing by
the AAE, basically the integrated configuration.

e Mediation capabilities of AAE
You can use the following adapters:
o RFC Adapter
o SAP Business Connector Adapter
o File/FTP Adapter
o JDBC Adapter
o JMS Adapter
o SOAP Adapter
o Marketplace Adapter
o Mail Adapter
o RNIF Adapter
o CDIX Adapter
o |Doc Adapter (Advanced Adapter Engine) (adapter type IDOC_AAE
o HTTP Adapter (Advanced Adapter Engine) (adapter type HTTP_AAE)

Dependencies

Advanced Adapter Engine Extended requires AS Java, Pl Adapter Engine, and Enterprise Services Repository as a
prerequisite in the same system.

These product instances are automatically installed when you choose the installation option Advanced Adapter
Engine Extended.

Functional Units
Advanced Adapter Engine Extended comprises the identically named functional unit.
Process Integration (PI)

Pl consists of core components that model, design, automate, and integrate processes in one or more application
systems. For the integration of internal and cross-company processes, Pl is used to incorporate all the functions
of what was formerly known as Exchange Infrastructure (XI). In addition, Pl contains core components for cross-
component Business Process Management (ccBPM) for application-embedded and application-unbounded
processes.

Dependencies

Plrequires AS ABAP, AS Java, Pl Adapter Engine, and Enterprise Services Repository as a prerequisite in the
same system.
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For installing PI, it is mandatory to have a dedicated Pl system. This applies to development, quality, and
production landscapes. It is a prerequisite that no other system in your system landscape has a higher release
and enhancement package level than the Pl system. If you want to upgrade or install an application in your system
landscape, you first have to make sure that the current release and enhancement package level of the Pl system is
on the same level - if required, you have to upgrade the Pl system first to the new or a higher release. In a
dedicated Pl system, this can be accomplished with a minimum of downtime. Also, the Pl system would not be
affected by the downtime of other product instances running in the same system.

Functional Units

Process Integration comprises the functional unit SAP Process Integration.

A.2.3 Standalone Engines

For SAP NetWeaver, the following standalone engines are available:
Adapter Engine Java SE

Adapter Engine (Java SE) is a separate software unit. You can use it only if you have SAP NetWeaver systems with
product instance Pl in your system landscape. It has to be installed manually. You use the Adapter Engine (Java
SE) to connect to external systems. Using the various adapters in the Adapter Engine (Java SE), XML and HTTP-
based messages can be converted to the specific protocol and format required by such systems, and the other
way around. The Adapter Engine (Java SE) only provides some of these adapters as a standalone version with
restricted functions for operating systems that do not support SAP PI, but that have at least a Java Runtime
Environment 5.0. Therefore, you should use the Adapter Engine (Java SE) only if the platform prerequisites do not
allow you to use the Advanced Adapter Engine.

Content Server

Content Server is a separate server instance that is used to store documents or other types of content related to
SAP applications. The accompanying cache server can cache content if your company operates in several
locations. This reduces load on the wide area network when working with documents.

SAP Gateway Foundation

As of SAP NetWeaver 7.4 the central software components of SAP Gateway have been directly integrated into
SAP NetWeaver in the form of software component SAP Gateway Foundation (SAP_GWFND). This component is
automatically part of SAP NetWeaver 7.4 and higher.

SAP Gateway Foundation facilitates easier provisioning and consumption of business logic and content of SAP
back-end systems for mobile and web applications. It aims to reduce the complexity and the skill set required to
access SAP data, thereby removing deployment barriers. Simple interfaces also help to shorten development
times.

SAP Gateway Foundation enables people-centric applications to consume SAP Business Suite data through
popular platforms and devices (such as the iPad and Blackberry) in an easy and standards-based manner. Itis a
framework that connects business users to SAP systems using consumer technologies, groupware, and mobile
devices and is based on open standards (such as the Atom Publishing Protocol and OData) that offer simple
services based on the REST principle.

Depending on your development requirements and where you want to develop SAP Gateway Foundation content,
you can install SAP NetWeaver in either an SAP Business Suite back-end system (embedded deployment) or in an
SAP Gateway Foundation hub system (central hub deployment).
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For more information, see http://help.sap.com/netweaver] SAP NetWeaver Platform » SAP NetWeaver <your
release> # Application Help ¥ Function-Oriented View » SAP Gateway Foundation (SAP_GWFND) 3.

liveCache

liveCache is a database engine for managing complex objects in scenarios where large volumes of data must be
permanently available and modifiable.

Search and Classification (TREX)

SAP NetWeaver Search and Classification (TREX) offers an integrated set of services. TREX services include
search and retrieval in large document collections, text mining, automatic document classification, and search
and aggregation over structured data in SAP applications. TREX can handle text from documents in numerous
formats, including Microsoft Office and Adobe formats (PDF), and more than 30 languages. TREX search options,
such as exact, Boolean, fuzzy, or linguistic search, and classification options such as query-based or example-
based classification, offer great power and flexibility to end users.

The BW accelerator is based on TREX technology. You need an installation based on 64-bit architecture for the
BW accelerator. The hardware partners provide this variant already preconfigured as the BW accelerator box.
Note that a TREX installation configured for searching in metadata and documents based on 32-bit architecture
cannot be used for the BW accelerator. Accordingly, a BW accelerator box also cannot be used for searching in
metadata and documents. In order to be able to use the search function and the BW accelerator, you need
separate installations.

Web Dispatcher

The Web Dispatcher lies between the Internet and your SAP system. It is the entry point for HTTP(s) requests into
your system, which consists of one or more SAP NetWeaver application servers. As a software Web switch, the
Web dispatcher can reject connections or accept them. When it accepts a connection, it balances the load to
ensure even distribution across the servers.

You can use the Web dispatcher in ABAP/Java systems and in pure Java systems, as well as in pure ABAP
systems.

It is also beneficial to use the Web Dispatcher if you do not need security functions (entry point in the demilitarized
zone (DMZ), SSL, URL filtering), but you simply want to balance the load between multiple SAP NetWeaver
Application Server instances.

Since Web Dispatcher is optional for every SAP system, it is not contained in the system landscapes of the use
cases in this documentation.

For more information, see the SAP Library at http://help.sap.com/nw75# | Application Help » SAP Function-
Oriented View » Application Server » Application Server Infrastructure » SAP Web Dispatcher .

A.2.4 Clients

With SAP NetWeaver, you can use the front-end clients and tools described below:
Adobe LiveCycle Designer

Adobe LiveCycle Designer enables the creation of forms that combine high-fidelity presentation with XML data
handling. The easy-to-use graphical interface of Adobe LiveCycle Designer enables users to quickly design forms,
maintain form templates, define a form's business logic, make changes, and preview forms before they are
deployed as Adobe PDF files.
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SAP NetWeaver Business Client

The SAP NetWeaver Business Client (NWBC) is a high fidelity desktop client that allows users to display their
assigned roles and to launch applications. SAP NetWeaver Business Client offers a unified environment for and a
single point of entry to SAP business applications and technologies. NWBC is ideal for displaying business
applications such as classical SAP GUI Uls, Web Dynpro Uls, BSP pages, and other content using its multiple
rendering engines. NWBC provides role-based access to applications either via the portal or directly using PFCG
roles. In addition to the basic capabilities detailed above, the SAP NetWeaver Business Client makes use of its
tight desktop integration to provide additional benefits such as desktop search functionality. In the newest SAP
NetWeaver Business Client version you will find the improved user interface (Ul) based on the SAP Signature
design. This Ul offers in part an expert-based interactive paradigm and a superior look and feel matching the
expectations of today's users aiming to maximize their daily activities.

The SAP NetWeaver Business Client is one of the main components of the User Interface Add-On for SAP
NetWeaver. For more information, see the SAP Help Portal at http://help.sap.com/nw-uiaddon# | Application

Help 3.
Business Explorer (Bl Add-On)

Business Explorer provides flexible reporting and analysis tools for strategic analyses and decision-making
support within a company. These tools include query, reporting, and analysis functions. As an employee with
access authorization, you can evaluate past or current data on various levels of detail and from different
perspectives, not only on the Web but also in Microsoft Excel.

You can use Business Explorer Information Broadcasting to distribute Business Intelligence content by e-mail
either as precalculated documents with historical data, or as links with live data. You can also publish it to the SAP
Enterprise Portal.

Additionally to Business Explorer you may want to consider using tools from the SAP BusinessObjects Analysis
family, such as Analysis, edition for Microsoft Office. The SAP BusinessObjects Analysis clients are specifically
designed for the needs of BW users. Note that SAP BusinessObjects products require separate licenses. For more
information on SAP Business Explorer, see http://scn.sap.com/community/business-explorer .

SAP GUI

SAP offers three different client applications for accessing ABAP applications in SAP systems (such as SAP
NetWeaver systems with product instance AS ABAP). This SAP GUI family consists of:

e SAP GUI for HTML
SAP GUI for HTML is based on the SAP integrated Internet Transaction Server (ITS) which is included in the
installation of SAP NetWeaver systems as of SAP NetWeaver 7.0. On the client side, only a suitable browser
and a virtual machine are required. For information about supported browser versions, see the Product
Availability Matrix on SAP Service Marketplace at http://service.sap.com/pam#r .

e SAP GUI for the Java environment (SAP GUI for Java)
SAP GUI for Java is a generic SAP GUI that covers a variety of platforms.
For more information about the installation of SAP GUI for Java, see the documentation Installation Guide —
SAP Front End.

e SAP GUI for the Windows environment (SAP GUI for Windows)
SAP GUI for Windows is SAP's universal client for accessing all SAP applications built on ABAP technology. It
is available on the Microsoft Windows platform only and offers the broadest feature set of all members of the
SAP GUI family.
For more information about the installation of SAP GUI for Windows, see the Installation Guide — SAP Front
End.
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SAP GUI also includes optional add-ons, such as the Business Explorer (Bl add-on) and KW add-on, which might
be required to use certain SAP NetWeaver capabilities.

1 Note

Data warehousing: SAP GUI for HTML and SAP GUI for Java do not have all the capabilities of SAP GUI for
Windows. BEx Query Designer, BEx Analyzer and Uls with network controls are not supported with SAP GUI for
HTML and SAP GUI for Java.

The following SAP GUI versions are supported with SAP NetWeaver 7.5:

e SAP GUI for Windows 7.40 (or higher)
e SAP GUI for Java 7.40 (or higher)
e SAPintegrated ITS

For more information about the SAP GUI family, see SAP Community Network at http://scn.sap.com/
community/guire.

Mobile Client

Mobile Client is installed locally on mobile devices, and is equipped with a Web server, a database layer, and a
framework for the mobile applications. Staff working remotely can therefore work offline and do not have to wait
for a network connection to complete time-critical business applications. Product instance Mobile offers tools for
synchronization and data replication that make the data of the mobile device consistent with that of the back-end
system.

Modeling Tools for SAP BW powered by SAP HANA

The Modeling Tools for SAP BW powered by SAP HANA (BW Modeling Tools) represent a modeling IDE
(Integrated Development Environment) build on top of the Eclipse platform.

Its main objective is to support BW model developers in today's increasingly complex Bl environments by offering
state-of-the-art modeling tools for BW objects such as InfoObjects, DataStoreObjects (advanced), or Queries.
These tools include integration with SAP HANA modeling and the consumption of SAP HANA elements in BW
Open ODS Views or CompositeProviders with powerful Ul (user interface) capabilities.

SAP NetWeaver Developer Studio

The SAP NetWeaver Developer Studio (NWDS) is SAP’s Integrated Development Environment (IDE) for Java and
is based on the open-source tools framework Eclipse 3.5. With the SAP NetWeaver Developer Studio, you can
develop Java EE 5 applications from scratch using the built-in support for new technologies such as EJB 3.0 and
JSF1.2.

ABAP Development Tools for SAP NetWeaver

ABAP Development Tools for SAP NetWeaver is the IDE for ABAP development on the open Eclipse platform. It
combines capabilities of the ABAP Application Server — such as convenient lifecycle management, server-based
development paradigm, full integration, effective testing, and troubleshooting tools — with the Eclipse Ul on top of
the ABAP platform.

For more information about the ABAP Development Tools, see Custom Application Development (ABAP) [page
41]

SAP Enterprise Services Explorer Tool for Microsoft .NET

As part of its service-oriented architecture (SOA) offering, SAP provides a set of consumer tools that allow the
discovery and consumption of enterprise services from various development environments, such as NetWeaver
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Developer Studio, Visual Composer, and Microsoft Visual Studio. SAP Enterprise Services Explorer tool for
Microsoft .NET (ES Explorer for .NET) is an add-on for Microsoft Visual Studio 2005 and Microsoft Visual Studio
2008 that helps to leverage SOA by enabling .NET developers to discover SAP enterprise services and consume
them in their applications, as well as publish their own custom services. It is an important element of SAP -
Microsoft interoperability.

To download the tool, access documentation and other resources, see http://scn.sap.com/community/
interoperability/microsoft-net .

For the most up-to-date information about ES Explorer for NET, see SAP note 1259258 #r .
SAP Web IDE

1 Note
The Developer license for SAP NetWeaver customers does not include the right to use SAP Web IDE.

For more information on licensing, see https://scn.sap.com/docs/DOC-65930

SAP Web IDE is a Web-based integrated development tool. It empowers users to rapidly create apps for browsers
and mobile devices. It simplifies the end-to-end application lifecycle, for example, prototyping, development,
packaging, deployment, and customer extensions for SAP Fiori and SAPUI5 applications.

SAP Web IDE aims to increase development productivity by delivering a holistic development experience. Offered
as a cloud solution powered by SAP HANA Cloud Platform, no initial installation is required, and the local IT
infrastructure is untouched. It supports free-style coding, providing strong editors with capabilities of code
completion (SAPUI5, XML and JavaScript), code validation, beautifiers, and more.

In addition, a layout editor with drag-and-drop (WYSIWYG) capabilities further enables acceleration of app
development. Wizard-based templates and sample applications allow users to design new Uls easily and quickly,
following specific best practices. The finalized application can be deployed automatically on SAP HANA Cloud
Platform, an SAP NetWeaver ABAP Server, HCPms, or SMP, or it can be exported manually to any Web server.

Using its plugin framework, developers can enhance the SAP Web IDE with additional functionality, for example,
the Hybrid Application Toolkit allows users to create, test, and deploy Kapsel-enhanced Apache Cordova apps,
the SAP Fiori Overview Page plugin (OVP for creating and modifying OVP smart templates apps), the VizPacker
plugin for the creation of Analytics visual extensions, and more.

A.3 Compatibility Product Instances

Compatibility product instances are product instances that have been discontinued and are therefore not part of
the standard SAP NetWeaver installation. If you upgrade from a previous release, these product instances will of
course still exist in your systems if they have been present in the source release system.

There might be reasons for which you want to install these product instances. You can do this using the Software
Update Manager. Note that you can install these product instances only on existing SAP NetWeaver 7.5 Java
systems with at least product instance AS Java.

For more information and installation instructions, see the SUM guide for Java: Update Guide — Updating SAP
Systems Using Software Update Manager, for: Java, section Installing Additional Product Instances in an Existing
SAP System.
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Demo Applications

Demo Applications illustrate the usage of SAP Composition Environment for previous releases.

Guided Procedures

Guided Procedures is a framework for modeling and managing workflows using simple and user-friendly tools.
Guided Procedures enables access to multiple backend systems, consistently combining different types of
services and applications into processes. In addition, Guided Procedures supports collaboration, ad-hoc items,
and offline task management using interactive forms. It provides role-based access to tools and resources and
guidance through the workflows at runtime, thereby helping end users to easily identify and complete their tasks.

Dependencies

Guided Procedures require Application Server Java, Composition Application Framework, Composition
Environment Platform as a prerequisite in the same system.

Functional Units

Guided Procedures comprise the identically named functional unit providing the above mentioned capabilities.

NWDS Update Site

You use the NWDS update site when you develop composite applications using several Developer Studio
installations. An update site contains all features for the Developer Studio. You can initiate a check for updates or
additional features in the Developer Studio and install them when available. The update site capability mirrors the
SAP Developer Studio update site on SAP Service Marketplace for an improved update performance. It does not
run on a multi-node cluster.

The NWDS update site has been replaced by an Eclipse-based solution.
Dependencies

NWDS update site requires Application Server Java as a prerequisite in the same system.
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a
binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does
not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency
(see: http://help.sap.com/disclaimer).
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for informational purposes only, without representation or warranty
of any kind, and SAP or its affiliated companies shall not be liable for
errors or omissions with respect to the materials. The only
warranties for SAP or SAP affiliate company products and services
are those that are set forth in the express warranty statements
accompanying such products and services, if any. Nothing herein
should be construed as constituting an additional warranty.

SAP and other SAP products and services mentioned herein as well
as their respective logos are trademarks or registered trademarks
of SAP SE (or an SAP affiliate company) in Germany and other
countries. All other product and service names mentioned are the
trademarks of their respective companies.

Please see http://www.sap.com/corporate-en/legal/copyright/
index.epx for additional trademark information and notices.
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